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Introduction

Decision Explorer® provides help with structuring and analysing the qualitative information that
surrounds the issues which are faced in everyday life. Whether the information is in the form of
(apparently) straightforward ideas, which require further exploration and scrutiny, or complex
ideas and events, which require structuring and analysis in order to manage their complexity,
Decision Explorer provides a framework that helps to "facilitate" decision making. The software
allows the user to work with a model of inter-linked ideas using maps. The computer screen acts
as a movable "window" onto the model, so the user can build up models which are much larger
than the screen can display at one time.
The aim of this User's Guide is to give an idea of some of the facilities available within the
program and some of the rationale as to why and how these facilities may be used.

1.1

What is a Decision Explorer Map?

A Decision Explorer map is made up of short phrases (known as concepts) whose relationships
are indicated by the links which are drawn between them. The concepts and links are entered by
the user. Concepts can be moved, edited, given different display styles, attributed to sets and the
whole model can be analysed. You can continue to build and analyse the model until a full and
detailed picture of the issue in question has been created and the model has served its purpose.
The concepts and their associated links together form a model, which is stored as an individual
entity. These models are sometimes referred to as cognitive maps, cause maps or concept
maps depending on their origin and content. In academic references on mapping, the terms
"cognitive map", "cause map" and "concept map" are usually used to refer to the data set as a
whole. In the context of this user's guide and other Decision Explorer documentation the term
"model" is used to refer to the data set as a whole. Models are opened, closed, saved etc. The
term "map", however, is used in two ways. The first is in the context of the data set as a whole
(as when talking about cognitive mapping etc). The second is in the context of a "map view",
which may show only a part of the whole model, different views (map displays) of the model can
be generated and explored, and parts of the model can be mapped. The context will make the
reference clear, but it is helpful to point these distinctions out.

1.2

Starting Decision Explorer

Start Decision Explorer by using either Program Manager or the Start menu (according to the
operating system in use). When Decision Explorer starts a title display will appear on the screen
for a short period and will then disappear automatically.
Decision Explorer has to work with the current Windows configuration, which can vary depending
on how the computer has been set up. Since running Decision Explorer successfully depends on
the Windows configuration, there may be the slight possibility of some initial start-up problems.
These can occur when the computer is part of a network system or corporate service system.
Please consult the systems manager if there appears to be difficulties with loading and using
models.
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Creating a New Model

When Decision Explorer starts it will automatically load the last model that was opened or worked
on, unless the option has been disabled (using the Control menu Preferences item). To create a
new model, simply click the new model button
new model will be created with a blank window.

1.4

, or select the File menu New model item. A

Opening an Existing Model

Sample models are provided with Decision Explorer. To open an existing model select the File
menu Open model item, or click the Open button. The file selector will appear. Move the mouse
onto the model name (e.g. the sample model, xray.mdl) and double click the left mouse button.
Alternatively, select the model by clicking on the model name once, then click on the OK button.
The model will be opened ready for work. Decision Explorer also remembers the last few models
used and these are shown at the bottom of the File menu. To open one of these models simply
select a model name and it will open automatically. When any existing model is opened the last
screen which was displayed when the model was saved will appear.

1.5

Saving and Exiting

1.5.1

Saving

As with all software, frequent saving of data and the creation of back-ups is strongly
recommended. Although there is an automatic back-up facility, if for any reason the program
'crashes' and the computer has to be restarted, this facility may not be sufficient. To save a
model use the mouse to select the File menu Save model item.
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Note: The menu item also has a shortcut, Alt-S, shown in the File menu. This can be used to
speed up the operation, many items have such shortcuts. You can learn them as you use the
menus where they are displayed. Menus can also be selected using the keyboard, for example,
Alt-F selects the File menu and Alt-E selects the Edit menu (the relevant letter is underlined in
the menu name). Once in the File menu, the letter S then selects the Save model item. All menu
items can be selected this way.

1.5.2

Exiting

To exit from the program go to the File menu Exit item or press the shortcut keys Alt-Q. If the
model has been changed Decision Explorer will ask whether or not it should be saved. Clicking
on the 'Yes' button will ensure the model is saved. If changes have been made to the model that
are inappropriate or incorrect it may be useful to exit the model using the 'No' option and then reopen the model (this will keep the copy of the model before the changes were made). 'Cancel'
will stop the exit operation and the model which is being used will remain open.
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Note: After the 'Close' option has been chosen an empty grey window will be displayed to allow
another model to be opened. Using 'Exit' avoids this and exits Decision Explorer completely.
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What can I use Decision Explorer for?

Decision Explorer is a versatile mapping and analysis tool. Different people have found, and will
continue to find, different purposes for it and ways in which to use it. Originally designed to
support cognitive mapping, Decision Explorer was described as an "ideas management" tool. It
can still be considered as that but with further development it has blossomed into a flexible,
efficient and effective decision support tool. As a result, Decision Explorer can be used for any
situation where the structuring and analysis of qualitative information will help the user to
organise their thinking and to come to a satisfactory conclusion.
Decision Explorer can be used by anyone who wants to understand and arrive at conclusions
about issues which involve complexity and/or uncertainty. It can be used as a personal or a
group decision support tool, as a means of communicating ideas, for "mapping" interviews, for
illustrating chains of events or for project management. There are many different applications
which have been used in practice and which have been suggested to us, some of them include:
· Strategy development

· Competitor analysis

· Tracking the implementation of plans

· Planning sales tactics

· Focusing creativity in meetings

· Building corporate memory

· Scenario building

· Personal development planning

· Cognitive mapping

· Personal mapping

· Stakeholder analysis

· Identifying training requirements

· Report/document structuring

· Identifying competencies

· Resolving conflicts

· Interview analysis

· Organisational restructuring

· System dynamics modelling

· Influence diagrams

· Structured brainstorming

2.1

Using Decision Explorer you can...

· generate a map of ideas and pull them together into a coherent picture to help to improve
understanding of a situation
· discover the real issues behind the headline information using the advanced analysis facilities
· maintain the focus in group meetings by reducing the need to repeat ideas while building on
and around the information already on display
· resolve conflicts by entering different options and opinions and expanding the arguments and
reasoning to identify common ground
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· maintain the richness of data by managing the complexity of it, instead of having to use a
weaker overview of the information
· effectively present reasoning through the structure of the lines of argument in the map
· encourage group creativity by providing a visual stimulus - as ideas are recorded and displayed
on the screen new ideas are triggered
· build feasible, practical and acceptable solutions by combining the opinions of different people,
whether from individual interviews, group meetings or a combination of both
· see an explicit picture of an issue which clearly shows the inter-relatedness and interdependencies of different aspects of the issue, which can then be explored and debated.
All these things and lots more can be done, from use at a personal level to use at a business
level, from outlining the plot of a novel, to developing corporate strategy. As you become more
familiar with Decision Explorer and its capabilities you will start to devise your own way of using
the software.

2.2

Use in a Business Context

In a business context Decision Explorer can be used for:
· strategy development, perhaps using a methodology such as Strategic Option Development
and Analysis (SODA)
· building a corporate memory - building and recording the reasoning behind decisions;
providing a record of strategically significant information
· stakeholder analysis - identifying the organisations and/or individuals who have a "stake" in the
business and identifying and understanding the relationships between the players involved
· building models of process flows
· project management and monitoring
· evaluating the qualitative aspects of risk
· value management - achieving a shared understanding of what value means, within a
particular context
· knowledge gathering and structuring for expert systems development
· interview analysis and data gathering and structuring
· building a qualitative model to inform system dynamics modelling
Each of these uses is discussed in more detail below.
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Interview analysis and data gathering and structuring

This is the "classic" use of Decision Explorer. Cognitive mapping is used to gather and structure
interview data. You do not have to use Decision Explorer to carry out a cognitive mapping
exercise, maps can be drawn by hand. However, with large maps and a lot of data, Decision
Explorer comes into its own. The multiple views and analysis facilities allow you to explore the
interview data. For an individual skilled in both the use of Decision Explorer and the cognitive
mapping technique interview data can be entered directly into the software. This removes the
need for transcription of interview tapes. "Live" mapping is, in fact, the preferred mode of
operation for cognitive mapping. Mapping in real time allows you, as the interviewer, to formulate
appropriate questions, to check back and consolidate understanding and exploring the emergent
properties of the map.
A description of the cognitive mapping technique is given in the online help.

2.2.2

Strategy development

One methodology, which has been developed to help with the strategy formulation process, is a
methodology known as strategic option development and analysis (SODA). SODA has been
pioneered by Colin Eden and Fran Ackermann, initially at Bath University and subsequently, at
Strathclyde University. The methodology uses cognitive mapping to express the thoughts and
opinions of a decision making group, in order to support strategic thinking. In broad terms the
SODA process uses an appropriate combination of the following steps:
1. Interviews - carried out in a relatively open, unstructured manner, focusing on the "label"
which has been given to the issue in question. Mapping is used to identify key issues in the
interviewee's thinking and to guide the interview agenda. Questions build on one another,
further questioning is grounded in what has gone before and has been revealed by the
cognitive map.
2. Computer modelling and analysis - after the interviews the interviewer constructs a model
of the information (the "knowledge and arguments") which have been gathered. This group
map combines the information drawn from the individual interviews. It is used to explore the
different opinions which have been gathered, so that goals, and their supporting
assumptions, key issues, options and actions are identified.
3. Group workshop(s) - from analysing the Decision Explorer model an agenda for a group
meeting is generated. Ideally, the group meeting involves a number of the original
interviewees, but may also include other appropriate individuals. The model is used as a
focus for discussion, it is discussed and debated, conflicts are explored and resolved and an
action plan is agreed upon. Other techniques, such as oval mapping and "post-it®" sessions
are also used in these workshops. These are used to elicit more information about the issue
under discussion. The process of elaborating the model and focusing on emergent goals
may not be completed in a single workshop session.
4. Group decision support workshop - the software is used on a public display to identify the
possible strategic options and the number of goals which can be reached from each option.
The goal system is refined, appropriate strategies to meet the goals are agreed together with
an action programme to achieve the strategies.
5. Tracking, control and review - the model which is the result of this process can be used to
track and monitor the progress of the action plan.
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More information about the SODA process is given in the following references:
Eden, C (1989), Strategic options development and analysis - SODA, in J Rosenhead (ed),
Rational analysis for a problematic world. Wiley, London.
Eden, C (1990), Strategic thinking with computers, Long Range Planning Vol. 23, No 6. pp35-43
Eden, C & Ackermann, F (1992), Strategy development and implementation - the role of a group
decision support system, in Robert P Bostrom et al (eds), Computer augmented teamwork: a
guided tour, Van Mostrad Reinhold.
Building on further research and the experience gained from SODA exercises, the process has
been refined and Eden and Ackermann now talk about "journey making". Their most up to date
thinking is reflected in their book, Making Strategy - The Journey of Strategic Management,
published in 1998 by Sage Publications (ISBN 0 7619 5225 X).

2.2.3

Corporate memory

Maps provide a very convenient and efficient way of storing information. They can be used to
provide a "corporate memory" in two ways. The first is that they can be used to record the
reasoning behind decisions, from meeting to meeting, rather than just providing a record of the
final outcomes. Simply recording the final outcomes or decisions can lose a lot of important
information. When a situation changes, the reasoning behind a particular decision can become
very important, and is often difficult to reconstruct … "I know that there is a reason for it, I just
can't remember what it was!" Using mapping in meetings where important decisions are being
taken means that the thought processes that were gone through to justify the decision can be
captured and revisited when the circumstances require it.
The second way in which mapping can be used to provide a "corporate memory" is in providing a
record of external strategically significant information. Event maps, that is maps showing chains
of past, current and possible future events occurring in the organisation's business environment
can be circulated (or posted on a central server) and periodically updated. The maps show the
inter-relationships between events occurring in the business environment. They can be used to
identify trends in the business environment, the influences on these trends and what might make
a trend play out in one particular way rather than another. These maps can be used to inform
strategic thinking.

2.2.4

Stakeholder analysis

Stakeholder analysis is about identifying the organisations and/or individuals who have an
interest in and can influence your business. Mapping can be used to gain a clearer, more
integrated picture of the relationships between an organisation and its stakeholders. It can be
used to highlight any areas which could be exploited through some form of collaboration
agreement and areas of potential difficulty or conflict. Understanding clearly the relationship
between an organisation and its stakeholders is important for business planning.
The stakeholders' characteristics (their perceived goals) are expressed and shown on a map.
The organisation's own goals are then added and the inter-relationship between the
organisations goals and the stakeholders goals are elaborated for each stakeholder. Details of
the inter-relationships are revealed by considering two questions. Firstly, how can or does the
stakeholder contribute to the achievement of the organisation's goals? And secondly, how can or
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does the organisation contribute to the stakeholders achieving their goals? Through the process
of mapping these inter-relationships the power structure of the organisation's business
environment is revealed and made explicit, so that it can be examined and explored. It may
become obvious, for example, that it does not make sense for a stakeholder to follow a particular
course of action, equally the process should serve to highlight what courses of action are open to
the organisation, given any restrictions placed upon them by their stakeholders.

2.2.5

Process flow charts

Within an "active" or "working" system it is possible to identify process flows. The soft systems
methodology allows people to define primary tasks: transformations that they think that their
system should be able to achieve or perform. In this context a "system" is their organisational
system, it might be a public library, a hospital or a business. For a business a transformation
might be that customer demand leads to profit, for a public library it might be that the service it
provides leads to an enhanced provision for local education.
These transformations are decomposed into a set of interconnected activities which need to be
performed in order to achieve the transformations. The result of this process is a high level data
flow diagram, except that the links between the activities are not just data but can be any sort of
interconnectedness - information flow, dependency, causality etc. Initially the nature of the
connection is not important because this is explored in further stages of the analysis. The
diagram serves to provide a visual stimulus for people to explore activities, suggest problems
and to develop an explicit and shared understanding of their system. The diagram shows work
flows and feedback loops. Loops can be identified using the loop analysis command in Decision
Explorer. Display styles can be used to show systems boundaries, this is the equivalent of
"drawing a bubble" around groups of activities. This can be used to identify sub-sets of activities
in your system over which you have control.
References:
Checkland, P (1981), Systems thinking, systems practice, Wiley, Chichester.
Checkland, P & Scholes, J (1990), Soft systems methodology in action, Wiley, Chichester.

2.2.6

Project management and monitoring

Decision Explorer can be used as a project management tool. Having used it to identify the
issues and actions involved in a project, maps detailing individual action plans can be developed.
Sets and styles can be used to help monitor the implementation of the decisions which have
been reached. Progress can be tracked by changing the display styles of concepts as their action
status changes. As the project progresses the model can be augmented and new issues, options
and actions explored.
Decision Explorer cannot replace a good project management package, it cannot get into the
sort of detailed work break down structures that are found in project management packages. But
for tackling the implementation of strategy Decision Explorer can be a suitable tool.
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Risk management

Risk management is devoted to minimising the impact and effects of uncontrollable occurrences
and of accidental losses. The methods associated with risk management are often seen as being
quantitative, numerical methods using calculations based on subjective probabilities. Decision
Explorer is a qualitative tool. There are qualitative aspects of risk; peoples' perceptions of risk
vary; options are ranked and compared differently. Decision Explorer allows you to explore
attitudes to risk and to look at the inter-relationships and the interdependencies between risk
factors. It allows you to build models which identify risks and risk owners, to explore the likelihood
of the risk occurring and the possible consequences, to explore options for accommodating risk,
to identify transferable risks and to go on to build "scenarios" of the outcomes.
Reference:
Williams, T, Ackermann F R, Eden C L, (1997), Project risk: systemicity, cause mapping and a
scenario approach, Project risk management conference, Helsinki.

2.2.8

Value Management

Value management is concerned with developing a shared understanding amongst the project
stakeholders of what value means. The purpose of value management is to achieve a common
perception of the issues inherent in a project and to reach consensus regarding the relative
merits of various courses of action. Clients or procuring organisations will possess differing
opinions about the need or the problem which the project is intended to fulfil or solve. Of central
importance are issues such as conflicting objectives, contrasting value judgements and internal
politics, which are unlikely to be discussed openly but which will obviously have a bearing on the
actions of the stakeholder. Value management is about working with a project team (including
the client) to build up a picture of how the client's expectations will be fulfilled. Only by
understanding the client's perceptions of value can aspirations about "value for money" be
fulfilled.

2.2.9

Knowledge gathering and structuring for expert
systems development

The purpose of an expert system is to encapsulate the knowledge of an expert in a form that can
be interrogated. An expert system is typically programmed using a specialist rules-based
language. A knowledge engineer will interview the expert (or experts) and build a set of rules
representing their understanding of the expert's experience. A problem arises when a knowledge
engineer attempts to have the expert verify the rules. The expert has no idea how to interpret the
rules-based language and therefore is typically unable to provide the verification required.
A cognitive map works well as an intermediate stage in this process. The knowledge engineer
works with the expert to build a map of the expertise. Because there are no specialist symbols
and no rules-based language involved the expert is easily able to understand the map and to
spot any flaws. Further, because mapping is good at representing the views of a group of people,
a model of many experts' knowledge can be built and conflicts can be resolved.
The only specialist modification to mapping that is required in knowledge gathering is to the map
logic. For example, an expert may say that a "major disaster" will occur if any one of a number of
factors is present or it may only occur if all of the factors are present. To represent this Decision
Explorer's "link logic" facilities are used. The logic command allows you to indicate that a

© 2017 Banxia Software Ltd

14

Decision Explorer® User's Guide

particular concept is an OR concept, in which case any one of the inputs can cause it to be true,
or an AND concept, in which case all of the inputs need to be true before it is also true. AND
concepts are shown on screen by each incoming link having an '&' character. If you have
complex situations ((A or B) and (C or D)), you must break them into separate concepts, which
has the side-effect of assisting with rule making later on.
Once the model has been built and agreed with the expert(s), the knowledge engineer has a well
defined representation of the knowledge which can be built into rules, without them having to be
verified by the expert (since the expert has already discussed and validated the cognitive map).

2.2.10

System dynamics modelling

Decision Explorer can be used to build a qualitative model that can then be used to inform
system dynamics modelling. The start of this process is likely to be the construction of one or
more cognitive maps, from interviews with appropriate individuals. These maps are then merged,
discussed and validated. It is important to get the management or project team to agree on the
definition of the problem and on the system to be addressed. So, it is a matter of problem
structuring, exploring the different definitions of the system, of identifying feedback loops, the
initial triggers in the system and internal and external influences on the system. As a result of the
mapping exercise an influence diagram can be constructed. The original model is kept intact,
maintaining a record of the initial and ongoing debate. The influence diagram is a higher level
version of the validated model (the aggregated cognitive map which has been discussed and
debated). The aggregated map and the influence diagram differ in terms of the level of detail
contained in each of them.
References:
Eden, C, (1994), Cognitive mapping and problem structuring for system dynamics model building
, System dynamics review. Vol 10, nos.2-3 (Summer-Fall 1994). John Wiley & Sons.
Ackermann, F, Tait, A, Eden, C and Willams, T, COPE-ing with system dynamics - a story of soft
and hard OR, Working paper 94/14, Dept of Management Science: Theory, method and practice
series. University of Strathclyde.

2.3

Use in an Academic Context

Decision Explorer is an excellent tool for academic research. Academic research is very varied
so it is hard to provide a list of all the possible uses. Users span many academic disciplines from
medical faculties, through design and arts departments, to mathematics and operation research
departments. Data exists in a qualitative form in many different contexts and Decision Explorer is
a tool that can help you manage it. We suggest that you review the examples in the business and
personal context sections to see how these suggested uses of Decision Explorer may be
developed to meet your requirements. Remember though that everyone uses Decision Explorer
in their own way - there is no prescribed method.
In an academic context Decision Explorer can be used for:
· qualitative data analysis
· interview recording and analysis

© 2017 Banxia Software Ltd

What can I use Decision Explorer for?

15

· project design and management
· report and document structuring

2.4

Use in a Personal Context

Decision Explorer can be helpful in everyday life. It is not just a tool which has to stay in the
office, for dealing with office based, commercial decisions.
In a personal context Decision Explorer can be used as:
· a decision support tool to help with the "big" decisions in your life, such as where to live/moving
house, changing jobs - thinking about the pros and cons of a particular job offer, deciding on a
change in career or evaluating the pros and cons associated with a big and expensive
purchase.
· a personalised planning tool, that is project management but at a personal level. For example,
planning a wedding, constructing and executing a personal development plan and monitoring
your progress, document structuring for essays, presentations, and book outlines.
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How do I use Decision Explorer?

There are two aspects to using Decision Explorer. The mechanics of using the software and the
details of the particular application or technique being used. This User's Guide helps you with
both aspects, and this chapter discusses the applications and techniques rather than the
mechanics, which are discussed later.
The key to using Decision Explorer is to spend a little time considering how the data will be
managed. This means thinking about which display conventions will be used and how the data
will be structured. In fact, one consideration is whether or not any premeditated attempt to
structure the data will be made at all. Will the structure of the data be allowed to emerge? And
what are the most appropriate forms of analysis to apply to the data and why? To help you with
these questions we have made some suggestions, in the following sections.
One point before we move on to a more detailed discussion of some of the considerations
involved in the use of Decision Explorer. When we were talking about what a Decision Explorer
map is we said, "…until a full and detailed picture of the issue in question has been created …".
But what constitutes a "full and detailed" picture? When is a model "the right size"? The answer
might seem a little trite but the answer is when the end user is satisfied. There is no point in
trying to build ever bigger and bigger models. It depends on the purpose of the model, what you
are trying to achieve and the information that you are trying to convey. If you are trying to
communicate an idea, then a small, clear, well-structured model will suffice. If you are analysing
a particularly fraught and complex issue then you will, almost inevitably, end up with a large
model.

3.1

Categories of Use

When discussing the use of Decision Explorer in general terms there are three overarching
purposes in its use. These are as:
· a recording and facilitation tool to encourage idea generation and information exchange (for
brainstorming, creative thinking, encouraging reflective thinking)
· a tool for structuring data, be it project data, data from a group discussion, individual
interviews, information extracted from printed/published sources or any other form of
qualitative data
· a means of communicating ideas clearly, efficiently and effectively.
As you become more familiar with Decision Explorer you are likely to feel that you can make a
transition between use as a personal analysis tool, to use with other individuals, in groups and
then live, in group meetings.

3.1.1

A facilitation tool - encouraging idea generation

Decision Explorer is particularly useful in settings where the issues surrounding a problem or
opportunity are complex. The relationship between factors and the reasoning attached to their
organisation is made obvious by the mapping process. Consider the situation where a group of
people has to make a decision or come to a conclusion about a particularly complex or
contentious issue. In such circumstances is it very important that all the factors surrounding the
issue are considered, understood and evaluated. If the issue is contentious it may be difficult to
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discuss the factors associated with it in a rational and objective manner. Individuals may be
hesitant about expressing their views plainly. This is where Decision Explorer can help. The
various factors surrounding the issue can be expressed (anonymously if desired) and they can
then be displayed in context and explored by the group. By adding alternative outcomes a
solution may be found.
Having established the purpose of the exercise there are two ways of starting the mapping
process. The first is to carry out a series of individual interviews and to map the content of these
interviews using cognitive mapping. The second is to allow ideas about the issue to be
"brainstormed" or "dumped" onto the screen. In both cases the cognitive mapping technique can
be used to structure the information. Cognitive mapping is a specific and well-defined technique
for modelling ideas. Decision Explorer helps with the building and analysis of cognitive maps for
ideas structuring, problem solving and strategy development. A paper explaining the principles of
cognitive mapping is provided in the Decision Explorer help file and a brief outline of the cognitive
mapping technique is given below (see page 20).
An effective way to brainstorm and generate ideas is to work with an experienced Decision
Explorer user "driving the software" and entering data, while another individual acts as a focus for
the discussion, facilitating the smooth running of the event. Ideas about the issue or problem can
be aired and explored. Because the information is visible and easily available, people do not
have to repeat things or go over old ground. By presenting the ideas and opinions in a written
form, in natural language, peoples' thinking can be drawn out and made explicit to the group as a
whole. New ideas are likely to emerge, since putting the groups' thoughts into a map allows
everyone to see clearly the different perspectives on the issue and this can stimulate new
thinking.

3.1.2

A tool for structuring qualitative data

Decision Explorer was originally designed for representing and analysing "cognitive" maps, that is
a model of someone's thinking about an issue or problem. When building a model there are no
watertight rules and no final map which is "the definitive map". However, if the map is to be
analysed in a meaningful way then it is important to work to clear and consistent set of
conventions. This applies to any form of model building.
Decision Explorer can be used in any setting where the user wants to structure and analyse
qualitative data, be it from interviews or discussions (recorded or live) or from written or
electronic media.
The are two ways in which to go about data structuring, the first is to adopt a pre-planned
structure (as is used with the SODA methodology) and the second is the "no structure" or
emergent structuring approach. The second method is particularly useful when scenario building,
where it is important to allow the key issues to surface freely. This means that as you work with
the data, new structures, which you were not previously aware of, can emerge. Even when using
a pre-planned structure it is quite possible to see new information emerging and the structure
may have to be altered accordingly.
It is difficult to illustrate the idea of deliberately working without a pre-planned structure, but one
way in which to illustrate it is to ask you to imagine a bus filled with people. Your aim is simple, to
determine the inter-relationships between this random sample of people. Each person represents
a source of data. You have to identify the relationships (the structure) which links these people.
Just splitting them into the categories of male and female, adult and child, is not enough, you
have to look more deeply, looking at each individual in detail. Put all of their personal details
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(such as background, job, interests, hobbies etc) into a model and start linking the information
together to see what emerges. As you work with the data you might want to define some sets
and attribute data to them. The analysis tools can then be used to identify clusters of data, the
most heavily linked pieces of data and so on, depending on the level of detail of analysis which is
required.

3.1.3

A tool for communicating ideas

Decision Explorer can be used as a presentation tool to communicate your ideas to your
colleagues. The variety of styles and the "collapse" feature allow you to represent complex ideas
in a clear and efficient manner. The level of detail shown on the maps can be varied depending
on the audience. Maps are easy to understand and convey a lot of information in a succinct
manner. You can show how one idea leads to another, what the outcomes are or might be. The
analysis features allow you to identify quickly and easily those ideas which are pivotal.

3.2

General Model Building Considerations

Apart from the mechanics of using the software there are some general points to consider when
you are building models. These are the overall purpose of the model and the process of which
the model building forms a part, the character of the data that you will be dealing with, how the
information will be expressed (concept phraseology), how the link logic of the model (link types)
will be used, the classification of the data and how the memo card facility will be used.

3.2.1

Purpose

Why are you building this map? Thinking about the purpose of the exercise gives you clues to
model structure. For example, with strategy development you are likely to be looking for and
building a hierarchy of goals, development options and the relevant actions which you might have
to take to expedite them. If you are you interested in the detail of a particular operational problem
you may be identifying all the factors which impinge on it in order to identify critical tasks. For
scenario building (using event mapping) you are looking at occurrences in the organisation's
business environment, triggering events, their consequences and possible outcomes. Identifying
those key events which will really have big implications for the business and looking for
supporting and contradictory evidence giving pointers to how events might play out. Or you may
consider that the situation that you are dealing with is so unclear that you really do want to start
with a "blank sheet of paper" and just float ideas to see what emerges. So, the questions are
what are you trying to achieve? What are you looking for?

3.2.2

Character of the data

Where is the data that you are putting in your model coming from? If you are using information
from published/written sources what rules are you using to determine what is included in the
model and what is not? You will probably have to generate your own rules, but the key is to be
consistent.
What kind of map are you building? Depending on the type of data that you are working with you
may not be dealing with causal relationship. You may have to think about the meaning of the
links and make use of different link types. As well as causal, connotative and temporal links, you
can use user defined linked.

© 2017 Banxia Software Ltd

How do I use Decision Explorer?

3.2.3

21

Concept phraseology

The type of map that you are building and the material that you are working with will determine
how concepts should be phrased. If you are building a cognitive map, a cause map or mapping
events then an "action oriented" phraseology is needed. Where possible an active verb should be
used in the concepts to indicate how concept "A" leads to concept "B". For example "abolition of
labour restrictions" leads to "flexibility in resourcing contracts" which in turn may lead to "increase
in number of contracts" and so on.
You will find that when you are checking the link logic of the model and "reading" the maps that
any errors in phraseology will emerge and can be corrected.

3.2.4

Link types

When you first start using Decision Explorer you will find that the default link style is a causal link,
that is a single headed arrow. As well as causal links there are two other predefined link types,
connotative and temporal, and you can also define your own types.
If you want to create a link representing a two way relationship, as in a taxonomic or category
type relationship, using a link with an arrow head at each end, then simply use two causal links to
link the concepts in each direction.

3.2.5

Classification of the data

When thinking about the purpose of your model building exercise you may have been able to
predetermine the display styles and sets which you want to use to manage your data. However,
the point of the exercise may be to build the model and to allow the data sets or classifications to
emerge as you analyse the model, in which case different styles and sets are defined as the
model building processes.
Decision Explorer allows for 20 different user-defined screen display styles, the characteristic of
which can be varied through the use of changes in colour, borders and text font attributes. The
use of colour can be quite striking in map displays and can be used to add or reduce the
emphasis placed on particular pieces of data. Maps can also be printed out in colour if desired.

3.2.6

Use of memo cards

Decision Explorer has a memo card facility so that additional information about concepts can be
attached to them for reference, but this additional information is not visible on the screen. A
memo card is a window which has an editable reference title and an area for free text entry.
How do I decide what goes in to the concept text and what goes in to the memo cards? Since the
concepts should be limited to the smallest number of words needed to convey the idea or event,
all of the back-up material should be put into the memo cards. If you are mapping from a number
of different printed sources of text then you may want to put the source reference on the memo
cards and perhaps some more of the article from which the concept was taken. If you are
working with a number of cognitive maps and are producing a group, merged map, then you
might want to put additional information about the original contributor and the source of the
merged concepts into the memo cards (so that the origin of the merged concepts is recorded).
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Use in a group setting

What aspects of the use of Decision Explorer are peculiar to its use in a group setting? Having a
public display and projecting onto a screen is obviously a more "exposed" use of Decision
Explorer than use in a private or personal setting, so familiarity with the software is very
important. If you are not an "expert user", you may want to create possible styles and sets and
give more thought to likely model structure and the sequence of analysis options which will be
used, in advance of the live session. This does not mean that these thoughts are unalterable nothing is cast in stone - but it is better to have some ideas of what might happen before starting!
It is also best to work with two facilitators, one providing the focus for the session and
encouraging the discussion and debate, while the other enters the information into Decision
Explorer.
There is obviously a need to control and manage the session, so as well as thinking about the
general model building considerations, in a group setting some thought must be given to how the
event will be choreographed. For example, at what point (if at all) will the discussion stop and a
single individual, the facilitator or a consultant perhaps, work on the data? How will the process
be broken down? What are the landmarks? It is important to keep peoples attention and keep
the event flowing (so if you want to tidying up way the model looks, do it during coffee breaks,
when you have the room to yourself). Clearly communicate the aim of the session to the
participants. Explain what is expected of them and how the software will be used and integrated
into the process. And do not forget the technology involved, make sure that your computer has a
good specification CPU so that there is not a long time lag when analysis commands are being
carried out. Peoples' attention can wander if it takes more than 30 seconds or so to carry out an
analysis routine.
In group use, it is generally best to use the command line versions for operations because
menus and dialogs obscure the screen and distract the participants. The location of error
messages can also be changed to reduce dialogs further.

3.3

Mapping Techniques

3.3.1

Building "cognitive" maps

Cognitive maps and the exact detail of the technique used to build them may vary, not only from
person to person but also depending on the purpose for which the maps are intended. That is to
say, the guidelines given here constitute a technique, the detailed application of which may vary
from person to person. A map is not a reflection of some objective reality but rather a
representation of an individual's perceptions of an issue. Therefore, the guidelines below are
intended as an aid to building a map but should not be used as if they were the only possible set
of rules. The guidelines suggested are based upon a particular body of cognitive psychology
theory - "personal construct theory" (Kelly G A, (1955), The psychology of personal constructs: a
theory of personality, Norton, New York).
3.3.1.1

Steps to create a cognitive map

1. Think about the issue or topic for consideration and then identify the main points of
interest.
2. When ideas are expressed, break the main points up into short, distinct phrases,
expressing one idea per phrase. Expressing multiple ideas in a single phrase causes
problems when you begin to link phrases and look at their inter-relationships. Use
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statements rather than vague phrases or questions.
These phrases are called concepts (or "constructs") and are the building blocks for mapping.
More information on concepts and concept types is given in the Reference Manual. When
forming the concepts express thoughts as succinctly as possible and use an active verb
within the statement to make it clear that it is an action which has a consequence. For
example,
USE
better anticipation
videos are difficult to use
my car is unreliable (and)
buy a new car

DO NOT USE
I need to anticipate better
why are videos difficult to use?
my car is unreliable so I need a new one

3. Concepts should be written in natural language. To give a feeling of ownership of the map
to those involved try to use the language of the contributors. Cognitive maps are built for
individuals and a group map is the sum of a series of cognitive maps. If the information for a
map comes from a group of people, then the names of those affected by or responsible for
the concept's content may be put in or added to an attached memo card for clarity. This is
obviously not appropriate if the subject being dealt with is particularly sensitive and the
interviews have effectively been carried out anonymously.
4. Enter each concept on the map as it arises or as it is voiced.
5. Look at each concept in turn and consider if any of the other concepts link to it or each
other.
6. Links between concepts generally indicate that one concept 'causes' or 'may lead to'
another. (There are different types of links available and details are given in the Reference
Manual). If a concept seems to support or explain another, make a link, which appears as an
arrow on screen, from the supporting concept to the one it would lead to. If a concept seems
to be the consequence of another, make links into those which would be the outcome.
7. Links can be made at the same time as entering the concepts or once all the concepts are
on the map. When a chain of argument has been built up avoid the temptation of putting a
direct link between the concepts at the start and end of the chain. A map with every concept
linked to every other will not show much!
8. The map can now be elaborated further. If additional information comes to mind which
seems to be important or connected to the main topic then enter new concepts on the map.
Also, looking at each concept individually and the concepts which link into and/or out of it
often provides a source for elaboration. Do not be afraid to replace a direct link with a
suitably linked new concept which provides more information. The richness of a map comes
from the chains of argument from each concept.
9. It is useful to print the map occasionally and go over it manually as this gives an
opportunity to reflect on what has been entered and on the structure of the map. This is often
conducive to gaining insight or more ideas.
10. The above steps can be repeated continuously, building up the map as more information
becomes available.
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Structuring a cognitive map

Maps are generally structured hierarchically. When entering concepts and structuring the map
some things to consider and to look out for are:
What are the goals, aims or objectives? These tend to be broad statements of intent
and/or things which are good in themselves, they generally go to the top of the map and
will be supported by the strategic issues.
What are the key issues? These are concepts which have some or all of the following
characteristics: long term implications, high cost, they are irreversible, need a wide range
of actions to make them happen. It is often a good idea to identify these first as they help
to bring structure to the map as it is being built. Key issues are identified by:
a) being of emotional importance to the problem holder or group
b) being at the centre of map complexity with high domain and central scores i.e. a
large number of links going into and out of them.
What actions should be agreed to achieve the key issues?
What potential options are available to select the actions from? Options tend to be
the concepts which explain and therefore suggest potential solutions to the key issues.
Try to be as consistent as possible when categorising and structuring the map as this will result
in more meaningful results from any analysis carried out. Different concept types, such as the
goals, issues etc. can be given a separate style to make them easy to distinguish.
The model "Listen" which is supplied with Decision Explorer was based on a real case and
provides illustrations of the points made above and what a map can look like (see example
below).
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For simple maps, just going through the building process itself and printing out the final map may
be all that is required. For larger, more complex maps the next step is to analyse it. Details of the
analysis available in Decision Explorer are given in later sections. A paper on cognitive mapping
is given in the on-line help file in Decision Explorer.

3.3.2

Event Mapping

To a certain extent the principles of event mapping and cognitive mapping are similar but the
source and content of the models varies. Event mapping is building up a model of chains of
events, considering their causes and consequences. Unlike cognitive mapping, where the
information for the model is usually taken from interviews or "live" workshop or mapping session,
the information for event maps can be drawn from any of the many sources of information
available to us, from various forms of printed and audio visual media, as well as interviews.
3.3.2.1

Steps to create a basic map

1. As with cognitive mapping the first step is to identify the issue or topic under consideration
and to identify the main points of interest.
2. Break each point down into short, distinct phrases. Characterise one event per concept.
Look for distinct events rather than vague phrases or questions.
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When forming the concepts express events as succinctly as possible. Words such as
"probably", "likely", "possibly" etc should be avoided. Look for an active verb within the
statement to makes it clear that the event has a consequence. For example:
USE
minimum wage introduced
accept job offer
sterling crisis

DO NOT USE
minimum wage likely to be introduced
probably accept job offer
signs are that there may be a crisis as the
value of sterling plummets

Since the purpose of the model is to think about possible future events then the concepts
should express current happenings as events which have already happened. Source
references and annotation (if required) should be added in attached memo cards for clarity,
especially when working with multiple data sources.
3. Enter each concept on the map as it arises or identify it in the data sources.
4. Look at each concept in turn and consider its relationships. Links between concepts
generally indicate that one concept 'causes' or 'may lead to' another. If a concept seems to
support or explain another, make a link, which appears as an arrow on screen, from the
supporting concept to the one it would lead to. Where a concept seems to be the
consequence or outcome of another, make a link into those which would be outcomes, from
the 'cause' to the 'effect'.
5. As with any form of mapping, links can be made at the same time as entering the
concepts or once all the concepts are on the map. Again, when a chain of argument has
been built up avoid the temptation of putting a direct link between the concepts at the start
and end of the chain. A map with every concept linked to every other will not show much!
6. The map can now be elaborated further. If additional information comes to mind which
seems to be important or connected to the main topic then enter new concepts on the map.
Ask "so what?" questions, to identify the outcomes of events. Ask "what caused this event?"
to identify triggering events. Do not be afraid to replace a direct link with a suitably linked new
concept which provides more information or to break concepts down into two or more parts.
7. It is useful to print the map occasionally and go over it manually as this gives an
opportunity to reflect on what has been entered and the structure of the map. This is often
conducive to gaining insight or more ideas.
8. The above steps can be repeated continuously, building up the map as more information
becomes available.
3.3.2.2

Structuring the Map

There is usually some sort of hierarchical structure to event maps, moving from triggering events
through to the ultimate outcomes. When entering concepts and structuring the map some things
to consider and to look out for are:
What are the possible outcomes? Always ask the question, "so what?" These events
will sit at the top (conclusion) of the chains of events.
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What is driving change? Which factors or individuals are responsible for the changes
that are occurring? Why?
What are we "stuck with"? We often like to think that, for example, policies will change
with a change of government, but some things are "irreversible", if only because they are
not politically feasibly, rather than them being a practical impossibility. These are
concepts which have some or all of the following characteristics: they have long term
implications, involve high cost, are irreversible (when reasoned through).
What are the triggering events? What started the whole "thing" off?
Be as consistent as possible when categorising and structuring the map. Different concept types,
such as triggering events, outcomes etc. can be given a separate style to make them easy to
distinguish.
There are certain things which it is not useful to add to or leave in a model of this type. For
instance it is not usually useful to add general event statements, such as "economic performance
will improve". If all of the reasoning for an improvement in economic performance is provided
then the concept might be useful, but it would be rephrased to read "improved economic
performance" and a chain of events would lead up to it. It is also not useful to have "orphan"
concepts in event maps, that is concepts which have no supporting argument and no
consequences. These concepts should either be elaborated or moved into another model, to be
studied at a later date, when new information may be added to them.

3.3.3

Analysis and Model Checking

As you become more familiar with Decision Explorer you will develop your own sequence of
quick checks to "tidy up" your models and to check how they are shaping up in terms of content
and structure. The commands used for the quick checks which are suggested here are explained
in more detail later on in this User's Guide and in the reference manual.
There are over 40 analysis commands in Decision Explorer. These range from the
straightforward identification of the "heads" and "tails" in the model (identifying the concepts at
the end/top (heads) and at the beginning/bottom (tails) of the chains of concepts and links), to
more complex analysis of the data using measures such as "clustering", "centrality", "domain"
and "potency". These measures can be used to look at the structure of the model and to assess
the significance of certain pieces of data. The most appropriate form of analysis is not
necessarily the most complex. The Decision Explorer features which are used are contingent on
the purpose to which it is being applied.
3.3.3.1

Quick Checks

Heads - the LH command lists the heads in a model. Head concepts have no links going out of
them, they have no consequences. They are the concepts at the top (conclusion) of a chain of
argument. Heads are outcomes, conclusions, goals you would like to achieve or targets that you
are aiming for.
Listing the heads in a model provides a quick means of checking that they really are what they
should be. Sometimes concepts might appear as heads simply because the linking in the model
has not been completed or consequences are missing.
Tails - the LT command lists the tails in a model. Tails are concepts which have no supporting
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explanation. When tails are at the beginning of a chain of argument they are starting points,
triggering events or perhaps actions which have to be carried out. When tails appear higher up in
a model they provide supporting explanation to other concepts in the chain of argument.
Orphans - orphans are concepts which are not connected to any other concepts in the model.
The orphan command will list them. As with listing the heads and tails in a model, listing the
orphans provides a quick means of checking that concepts which should be linked into the model
have not been missed.
Listing styles - The L <stylename> command will list all of the concepts coded with a particular
style, e.g. L goals. This provides a quick means of checking that concepts are being shown with
the correct style.
Listing sets - The L <setname> command will list all of the concepts attributed to a particular
set, e.g. L production. Concepts can appear in more than one set but can only have one style.
Clusters - cluster analysis can be used to identify hierarchical clusters and "island" (directional)
clusters. The type of analysis performed is controlled through the analysis menu, cluster options
item. Clusters tend to focus on particular topics or themes, so they are groups of related ideas.
For a quick check on model structure the use of island clusters (identified by checking the option
for "direct - all directions") provides a means of checking that model themes are appropriately
separated or linked. Map each cluster to view the contents (e.g. map cluster1).
3.3.3.2

Simple analysis

Domain - domain (and central) analysis looks at the connectivity of concepts. The domain
analysis analyses the links immediately around each concept, to one level of links.
What does this analysis tell you? Domain analysis is used to identify "busy" concepts in a model.
Concepts which have either a high number of links going into them (highly elaborated) or have a
high number of links going out of them (a large number of consequences). These tend to be key
issues in a model.
Central - central analysis goes further than domain analysis in that is brings in the wider context
of the concepts. It looks at their connectivity to a specified level of linkages beyond the "central"
concepts. It is rather like looking at the ripples in a pond and the influence or effect of a concept
in its wider setting.
Cotail - cotail analysis looks for the "composite tails" in a model, that is concepts with two or
more outcomes. In general cotails are interesting because they have multiple consequences,
they are branch points in the lines of argument. In an event map a triggering event (which is a
cotail) with multiple possible outcomes might form the basis of two scenarios about possible
future events. In cognitive mapping and strategic development cotails (and in particular "potent"
cotails) are interesting because they can indicate the single actions which may allow mulitple
goals to be achieved.
Hieset and potent - hieset and potent analysis are used in conjunction with one another. The
hieset analysis, which is performed first, identifies hierarchical sets. These can be thought of as a
series of "tear-drops", which are made up of all of the concepts which support (explain) the
concepts in a seed set. So, for example, if you use the set "goals" as the seed set, then all of the
concepts which support each individual concept in the sets goals, will be identified and put into a
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series of hiesets. Potent analysis is then used to find the overlaps in these hiesets, that is the
concepts which, in this example, are members of more than one hieset and therefore support
more than one of the goals. By definition, if a concept is in more than one hieset, then it is also a
cotail.
3.3.3.3

Merging models

Merging two or more models together is a common requirement, and Decision Explorer provides
facilities to assist with this. Merging models can never be a truly automatic process - you will
always have to look at the data to find common areas - but the benefit is that you get to know the
data well.
To merge models, the following actions are necessary:
· Renumber each model to different number ranges (using the ren command)
· Select all concepts to be transferred into the composite model (using the SC = L command)
· Copy the selected concepts to the clipboard using either the Edit menu or command line
version of the Copy command.
· Switch to the composite model (it is best to create a new one)
· Paste from the clipboard using the Edit menu Paste item. It may be preferable to paste the
styles from the first model, and only the content from the others.
Then, the process of getting to know your data begins. Find common words (using the Find
command) and compare the context of each concept. Beware of the same wording meaning
different things - you may like to edit them for clarity. Use the "bring layout from view" facility to
get two maps on the same display. Merge concepts that are "identical" in meaning (merge
command). This will create bridges between the individual models. As the models become linked
use the standard tools, like mapping clusters, to identify more similarities in the maps.
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Basic Map Options

This section provides instructions on the facilities needed to start a map from the beginning and
build on it from there.

4.1

Entering Concepts into the Model

Concepts (short phrases describing an idea) are the basic building blocks of models,
consequently there are several ways to create them.

4.1.1

Using the mouse to enter concepts

Move the mouse to the space in the window where the new concept is to appear and double click
with the left button. A number will appear on the screen. The mouse pointer will change to an 'Ibeam' indicating text editing mode and type in text. The text cursor will be flashing next to the
number provided. Type in the concept text. As you type Decision Explorer will word-wrap
appropriately. After entering the concept's text, click with the mouse away from the concept, or
press Enter to indicate completion of text entry. To cancel the new concept, press Esc and it will
be removed. Esc is generally used to cancel activities.

4.1.2

Using the keyboard

Note: The mouse entry mode is the recommended mode, as it is easy to link up new concepts
to those existing on the screen.
Type an '=' character and then type the text required. For example =this is a concept. The
command line (at the bottom of the window) will appear as soon as the = key is pressed and will
remain until the Enter key is pressed. After pressing the Enter key, the program will find an
appropriate position on the screen and place the concept there. It may be difficult to locate the
concept if the screen is already full. The concept may disappear under another or be placed just
off the screen. To find the concept when this occurs, try linking the concept to whatever is
appropriate and the arrow will provide some indication. However, selecting a concept already on
the screen before entering another one via the keyboard will ensure that it is positioned nearby.
For further information on how to link using the keyboard please refer to the section dealing with
linking and unlinking concepts.

4.1.3

Editing concepts

Move the mouse over the concept in question and double click. The 'I-beam' cursor should
appear and the concept can be edited. The Ctrl and arrow keys allow fast movement between
words and the Home and End keys take the cursor to the beginning and end of the line (or
beginning and end of a concept if pressed twice). Otherwise, use the cursor to locate the place to
be changed or added to; use the Backspace or Delete keys as appropriate. When the editing is
complete, press the Enter key to end the editing or click on the mouse (left button) away from the
concept. To cancel the changes, press Esc and the original text will be restored.
When editing concepts in a scaled view (see Scaled Views 40 ) where the concept text has
become too small to read, the concept text will appear in the command line so that it is readable.
Move the 'I-beam' cursor to the beginning of the edit and click to position the text cursor. The left
and right cursor arrows can also be used to move about the concept text in the command line.
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When editing is completed, press e or click with the mouse away from the concept. When asked
to confirm the change, click on 'Yes' if satisfied with the changes made and 'No' if not and the
concept will remain unchanged.

4.1.4

Deleting a concept

There are several methods of deleting concepts to make it as easy as possible in any
circumstance. Most methods require that the concept or concepts are selected (see Selecting
Concepts 36 ) and use either the keyboard or the mouse.

Using the mouse :
Main menu
Shortcut menu
Toolbar

Using the keyboard:
Keyboard:
Command line:

4.1.5

Select the concept(s) then go to the 'Edit'
menu and select 'Delete'.
Click with the right mouse button over the
concept then select the 'Delete' option.
The standard toolbar set does not include a
delete button. It can be added to a toolbar if
required.

Select the concept(s) then press the Delete
key. This is probably the quickest method.
Type D and the concept number. This is
useful if the concept is not on the current map.

Undeleting a concept

To retrieve a concept that has been accidentally deleted, move the mouse to the 'Edit' menu and
then select the 'Undelete concept' option. This is also available on the shortcut menu. Note that
links cannot be undeleted.

4.2

Linking and Unlinking Concepts

A link is the arrow or line between two or more concepts. It is generally used to add meaning, for
example indicating a relationship between concepts or illustrating a chain of argument. There are
several types of links, of which the most commonly used, 'causal', will be commented on below.
Causal links are interpreted as representing 'may lead to' or 'is explained by'. Thus, where the
concept 'see it is raining' is linked to 'take an umbrella' it would be read as 'see that it is raining
may lead to take an umbrella'.
There are several methods available for linking concepts:
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Linking concepts that are on the screen using a mouse

To create an arrow linking one concept to another select the concept that is to be linked to the
other (i.e. the concept at the tail of the arrow), hold down the left mouse button on the concept.
As you move the mouse, the mouse pointer will change to a '?' symbol 'asking' where the link is
to be directed. Keeping the mouse button down, move the '?' using the mouse until it is over the
other concept (a dotted box will appear around that concept) then release the mouse button. The
Link Property Editor will appear, where the direction of a link can be set and the link made
negative (see relevant sections below). Click on the 'OK' button and an arrow will appear on the
screen between the concepts.
It is possible to turn off the Link Property Editor dialog so that it no longer automatically appears
when links are made by using the 'Control' menu 'Preferences' item, then under 'Prompts'
deselecting the 'Use Link Selector' option. Even when turned off the dialog can be forced to
appear by holding down the Ctrl key when creating a link.

4.2.2

Linking concepts using the keyboard

Another method to link two concepts together is to type X + Y (the command line will
automatically appear) where X is the 'from' concept and Y is the 'to' concept i.e. from X to Y.
Again an arrow will appear on screen. For example 23+41 will put a link from concept 23 to
concept 41. This method is fully described in the Help (press F1) and the Reference Manual.

4.2.3

Changing the direction of the link

If the direction of the link needs to be reversed (perhaps because it has been wrongly linked or
the reasoning has changed) then a double click on the link (somewhere about the middle is
recommended) will cause the Link Property Editor to appear in the middle of the screen. To
change the direction of the arrow click the arrow button between the numbers of the two
concepts being linked. In the example this would change the arrow to point towards 32.

4.2.4

Link types

The drop down list in the dialog contains the available link styles. In addition to causal links, a
model starts with other types such as Temporal. These are for special purposes - for simple
mapping just using causal links is generally advised as they are the most common and most of
the analysis have been designed with them in mind. Connotative links are 'bi-directional'. They
should be used with care as they can cause confusion in some of the analysis. You can define
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your own link styles with attributes such as thickness. This is done using the Edit button, and is
fully explained in the Reference Manual and Help.

4.2.5

Negative links

The Link Type Selector box also allows negative links to be made. Negative links allow those
ideas that lead to the opposite of the next idea to be linked. For example, a model builder may
wish to link "notice it is sunny" negatively to "take an umbrella". By activating the Link Type
Selector and selecting the 'Negative' checkbox a negative sign will appear by the arrow. Click on
'OK' to complete the link.
When creating a link using the mouse a negative link can be specified by holding down the Shift
key.
Alternatively entering X-Y on the command line will ensure that a negative link appears from
concept X to the opposite pole of concept Y. Command line entry is fully described in the Help
(F1) and the Reference Manual.

4.2.6

Deleting links

Links can be deleted by clicking on the link to select it (small boxes will appear at each end) and
pressing the Delete key. Selecting the link then double clicking on it will display the Link Property
Editor and clicking on the 'Delete' button will remove the link. The Edit menu Link Properties item
also activates the Link Property Editor. The shortcut menu also provides this function. To delete
links from the command line look up the 'DL' command in Help (F1) or in the Reference Manual.

4.2.7

Adding more than one link at once

For details on adding more than one link at once look up the '+' command in Help (F1) or in the
Reference Manual.

4.2.8

Fishing reel links

There may be times, especially when working in normal sized views in large maps, when
concepts are placed off the screen while still being part of the map and are only visible by the
long arrows between them. Rather than having to move around the map to look at or reposition
these concepts, they can be 'fished' or brought into a specific location using the 'fishing reel' link
facility. Control over the location of the 'fished' concept is achieved by placing the mouse pointer
on the arrow in question at the position where the concept is to appear. Hold down the Control
key while clicking the left mouse button and the arrow changes from being the default white or
black to a red/green combination. The concept at the green end of the arrow will remain in its
current position whereas the concept at the red end will be moved to where the mouse pointer is.
If the colours need to be transposed, i.e. the other concept is to be moved, then click once more
with the left button and the colours will swap around. To move the concept click the right mouse
button. The concept will now appear in the selected position. This may take some practice but is
a fast and efficient way to move concepts around the screen.
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Selecting Concepts

This is a basic procedure for many of the operations within Decision Explorer. To select a
concept, click once on it with the left button and a box will appear around the concept. This
procedure can be used to select more than one concept by holding down the Shift key while
selecting each concept. The box around the concepts indicates that the concept has been
selected.
The selected concepts comprise a set called 'SC' (for Selected Concepts) and will be referred to
as such in commands.
Alternatively, if concepts are adjacent to each other, move the mouse to the top left or right of the
group and holding down the left hand mouse button, drag across the screen so that the dotted
box encompasses those chosen. Those concepts that the expanding box either touches or
covers will be selected when the button is released.

4.4

Moving Concepts Around the Screen

4.4.1

Moving a single concept

Moving concepts allows the display to be improved for viewing and printing and enables the user
to deal with overlapping concepts or crossed links. To move a concept go to the concept to be
moved, hold down the left then right mouse buttons (the mouse pointer will change to a hand)
then, holding down the buttons, move the mouse until the concept is in the desired position. Let
go of both of the buttons, and the map will be redrawn. This command is also available in the
shortcut menu.

4.4.2

Moving multiple concepts

When separating or grouping chunks of information it can be useful to move more than one
concept at a time. To do this see " Selecting Concepts" above. To move this block of selected
concepts, move the mouse to one of the selected concepts, hold down the Shift key, then follow
the procedure for moving a single concept. All of the selected concepts will move.

4.5

Printing

4.5.1

Printing maps

To print a map either for future reference or to circulate ideas, select the 'File' menu 'Print' option.
A dialog box will appear allowing various options. (see Print Options figure alongside).

4.5.2

Printing lists

To print a list of concepts or the contents of a text view, simply follow the same procedure for
printing maps. Decision Explorer will print the entire text output, there is no need to scroll around
the text.
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Printing map titles

Maps can be printed with a customised title. In the 'Print Options' dialog select the 'Header/
Footer' tab. The text to be used as the header or footer of the map can be entered. There are
also a number of predetermined options which may be selected. They should be entered as a '$'
character followed by a letter i.e. $A: $M $V, which would print Decision Explorer, the model
name and the view name. Decision Explorer will remember the title for each printout.
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Viewing Concepts

5.1

The Multiple View Facility

5.1.1

Different map views

A view is a workspace to hold a layout of concepts. Decision Explorer allows you to work with at
least four views (the actual number depends on the license). Views allow different parts of the
model to be examined. This allows you, having built up a map of one particular area in one view,
to develop one of the ideas separately on another view. It is simple to switch between views - the
fastest method is to hold down the Alt key and press 1,2,3 or 4 etc, depending on which view is
required e.g. Alt-3 to change to view three. The view can also be changed using the tabs at the
bottom of the window, the main menu and the shortcut menu.

5.1.2

Text and map views

It is possible to view text screens (those containing lists) as well as map screens. This allows
each of the four views to have a text view and map view. This facility is useful when wishing to list
or find a concept then return to the map being worked on without losing any of the information.
For example, if the map appears to be missing a certain concept due to incorrect linkage, it is
possible to find the concept using a text view and then return to the map view and 'show' the
concept (see Showing hidden concepts 49 ).
To switch from a text view to a map view, using the keyboard, hold down the Alt key and press V
and M (View Map) i.e. Alt-V-M, and to switch from a map view to a text view hold down the Alt
key and press V and T (View Text) i.e. Alt-V-T.

5.2

Scaled Views

It is often desirable to see an overview of a map for layout improvement and in Decision Explorer
there is a facility which can scale maps for this purpose. This feature is accessed from the 'View'
menu 'Display Scale' sub-menu. All models start in 'Normal Size' with the option of selecting
either 'Half Size' or 'Fit to Window'. Half size does exactly that - reduces the size of all map
elements to 50%, displaying four times as much in the window. 'Fit to Window' scales the map to
whatever size is necessary to fit the whole map in the current window. When in a scaled mode, it
is often not possible to read the concept text easily. For this reason, a single click on a concept
displays the concept text on the command line at the bottom of the window. A double click allows
the text to be edited on the command line. The extra display can be removed at any time by
pressing Esc and it will be also automatically removed at other times. It is possible to turn off the
display of the concept permanently (not the editing) on the status bar by going to the 'Control'
menu 'Preferences' item and deselecting the 'Extra concept display in fit-to-view' option.
If a map is actually larger than the current window then the fit to window option does appropriate
scaling to ensure the whole map is displayed. Should the map display appear incorrect at any
time the 'redraw' function should be used - press F5 or go to the View menu and select the
'Redraw window' option.
The selected scale mode is set only for the current view, so it is possible to have an overview
map in one view and a normal size in another. Scaling is not available in the textual display.

© 2017 Banxia Software Ltd

Viewing Concepts

5.3

41

Saving and Retrieving Views

Although there are a number of views to use, it is sometimes beneficial to hold onto particular
layouts. Decision Explorer allows further views to be saved to disk for retrieval when necessary.
This facility can be used at any time, however retrieving views into a model which did not create
the view is not recommended.
To save a view use the View menu Save view option. This will cause a file selector to appear.
Type the filename you want and click OK and the map layout will be saved.
To retrieve the map use the View menu Load view option and either select the appropriate file
from the list or type in the name and click 'OK'. This will cause the stored map view to be
displayed instead of the map in the current view.

5.4

Protecting Map Views

It is possible to protect map views from accidental destruction while still allowing manual change.
For example a 'master map' could be protected while switching to other views to obtain more
detail about particular concepts. While not guaranteed, in that it may be possible to loose the
contents in a roundabout way, this provides a fair degree of protection for displays which are
being used as a 'master'. As standard, Decision Explorer will automatically protect a view when
you start moving concepts, but this can be disabled. To manually protect a view, go to the 'View'
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menu and select 'Protect View' (if this option is already ticked and is again selected, the view
protection toggles and the view will immediately become unprotected). A "(P)" in the title bar
indicates that the view is protected. The shortcut Alt-T can also be used to toggle view protection.
When a view is protected and a command which would erase it is executed, a dialog box will
appear (see example) in which you may either unprotect the current view or switch, with a
preview, to an unprotected view. If you have not reached the limit, a new view can be created.

5.5

Displaying Concepts in Lists

5.5.1

Listing all the concepts in the map

Various types of list reports are available by going to the 'List' menu and selecting the report
option required. A list of all the concepts in the map will be given by selecting 'All concepts', or by
typing L on the command line.

5.5.2

Working with large lists

In the case of larger models, the list may be stopped or paused by selecting the 'Stop' or 'Pause'
buttons that automatically appear. A 'Continue' button will appear when the listing has been
Paused to allow continuation.
To move up and down the list, press the Page Up or Page Down keys, or move the mouse to the
small box in the scroll bars and click and hold to drag the box either up or down the scroll bar as
required. Once the required position has been found the button can be released.
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Further Map Options

Once a model begins to grow in size there are various ways to explore and manipulate the
information which it contains. Some of these are detailed in this section.

6.1

Displaying Concepts as Maps

If a concept seems to be central to the idea or problem under consideration it may be worthwhile
to look in to it further and find out its importance or otherwise. Once a concept has been located
for exploring there are two possible viewing methods.

6.1.1

Exploring a concept's immediate domain

The simplest method for viewing a concept is to type X (for eXplore) and the concept number e.
g. X32. This provides a display showing concept 32 and all those concepts that either
immediately link into or out of 32 (see figure). Only one level of link is displayed. This is useful for
an initial review of a concept. This option is also available on the menus and by selecting a
concept and pressing Alt-X.

To build on this, XE7 (eXplore Explanations - these being the ideas leading into the concept) can
be used. This places only those concepts that are linked into 7 on the screen but this time shows
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two levels thereby providing the user with a greater insight into the explanations of concept 7.
Conversely, typing XC7 (eXplore the Consequences) will only show those concepts leading out
of 7 to two levels of links.

6.1.2

Mapping a concept to get a wider picture

To get a bigger picture, use the MAP command. This provides a wider view of the concept
because more than one or two levels of links are shown in both directions. This can be activated
by selecting the concept in question e.g. 7 and going to the 'Analysis' menu and selecting 'Map
concept' or by holding down the Alt key and pressing M i.e. Alt-M.
Alternatively this can be achieved by typing MAP 7. Where a concept has a considerable amount
of elaboration around it, (i.e. lots of ins and outs which are also highly elaborated) then the use of
these commands may result in an overly complex and too detailed picture, using the 'Fit to View'
mode may help. This option is also available on the shortcut menu.
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Mapping all the concepts

When initially building a small model it is also possible to use the 'mapall' command. This
operation maps all the concepts currently in the model and is useful when building up a model.

However, once the model has exceeded forty concepts this command is usually no longer useful
as the complexity of mapping a large number of concepts makes the display less than useful. If
the model is large it is usual to 'cluster' the information into groups using the cluster command,
(see Cluster 68 ), and map each cluster in turn. This is done using the MAP command followed
by the name of the set, e.g. map cluster1.

6.2

Consequences and Explanations

This facility allows the user to explore, in a text format, either the consequences or explanations
of a concept. The basic principle is similar to the XC or XE (eXplore Consequences or eXplore
Explanations respectively) commands except that it provides the information in a text format
rather than a map. Consequences are those concepts that lead 'out' of the concept in question,
and explanations those that lead 'in'. As in many other commands, either the mouse or the
keyboard can be used, although greater flexibility is gained through the keyboard.
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Using the mouse

To use the mouse, go to the 'Analysis' menu and select either 'Consequences' or 'Explanations'
and a dialog box will appear (see figure, showing the Consequences dialog box). Options are
chosen by selecting the required alternative.
It is possible either to list the consequences or explanations of a specified concept up to a branch
point - a point where there is an alternative route - or to heads or tails respectively - or to discover
routes between two specified concepts. To identify a route, both concept numbers need to be
entered into the boxes provided. For example, in the figure the analysis will show the immediate
routes out of concept 37.

6.2.2

Using the keyboard

A view of the immediate consequences or explanations up to the branch point can be achieved
by typing either C for consequences or E for explanations and then the concept number. For
example, C 45 will list the consequences of 45 and E 45 will list the explanations of 45.
To identify whether there are any routes between particular concepts, both the starting concept
and end concept must be specified. For example, to determine whether there is a route between
concept 35 and concept 66 type C 35 66. All routes will then be displayed. If any loops exist in
the route then this is reported.
Obtaining all the consequences or all the explanations is also possible. This is useful for
discovering how elaborated a concept is. Typing Path, followed by the form of search (either
Consequence or Explanation) and then the concept number will cause this analysis to be carried
out. For example, PathC 56 (Note: there is no space between Path and C) will produce a list of
all the routes and concepts that are consequences of concept 56 to the heads. PathE 50 will list
the explanations of concept 50 to the tails.
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6.3

Extending Existing Maps

6.3.1

Revealing hidden links

When working with large models, it is sometimes useful to be able to see whether there are any
other concepts linked to those displayed, but which have not themselves been displayed on the
current map. In the 'Property' menu, select 'Model display'. Under 'Unseen Links' there are
options for showing no links, for showing links for selected concepts or for showing links for all
concepts. Select the required option and click on 'OK' to return to the original screen. Press F5 to
redraw the screen and the hidden arrows will be displayed. If 'Selected Concepts' was chosen
then select a concept before redrawing. These unseen arrows can be displayed with or without
the concept numbers depending on whether the 'Include Numbers' box has been checked sometimes useful when printing to avoid too much detail.
Command line alternatives to the dialog options are also available. Look up SUL and HUL in the
Help or Reference Manual. Buttons on the toolbars are another alternative.
Note: The display of hidden concepts is sometimes imperfect for efficiency reasons. To tidy up
the window, press the F5 key (redraw).
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Showing hidden concepts

To display any hidden concepts of interest use the bring command. If the option is enabled,
each of the hidden arrows has a number at the end of it. By typing, for example, bring 51 the
program 'brings' concept 51 on to the screen. If more than one concept is to be placed onto the
screen it is possible to display them by typing bring 51&53&65. The '&', or if preferred '#', acts as
the separator between concept numbers when there is more than one concept to be displayed.
This facility to select which concepts to add to the map is useful when elaborating an area that is
particularly interesting and has additional information around it.
Note: If only one concept is selected, 'Bring' will position the concept(s) near it. Further
elaboration is easy as those concepts brought onto the screen will themselves display any further
linked concepts.
An alternative method is to select a concept and press Ctrl-B to 'bring' all those connected onto
the view. This option is also available on the menus. There are two keyboard only variants too.
Ctrl-I brings all the incoming concepts to the selected one. Ctrl-O brings all the outgoing ones.

6.3.3

Hiding concepts from a map view

In order to reduce complexity and to concentrate on a particular aspect or clear an area of
concepts it is useful to remove or 'hide' those concepts not needed from the screen. To hide a
single concept select it and press Ctrl-H. Alternatively, type hide and the concept number e.g.
hide 45. The concept is retained in the model but removed from the current map view. This
option is also available in the shortcut menu.
To hide multiple concepts type hide concept number & concept number etc. e.g. hide
56&77&89&54. To hide selected concepts type hide sc (see Selecting Concepts 36 )

6.4

Finding a Concept Containing Specific Text

To find concepts with a particular word in them, select the 'List' menu 'Find text in concepts'
option. The dialog allows you to enter the word and choose between modes which determine
whether the search is for whole words or case dependant.
A command line version, Find, is also available and documented in the Help (F1) and the
Reference Manual.
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Styles

In order to be able to distinguish between particular categories of ideas, concepts can be
differentiated using different colours and fonts. For example, when building a model it may be
useful to be able to identify goals, key issues, and potential options using a different colour for
each. To distinguish them on a black and white printout it is also useful to use a different font for
each category. Alternatively styles may be created for particular categories of concepts, such as
those concerning finance, people, or for those actions that are the responsibility of one particular
person.

7.1

Defining concept styles

To define a concept style (a combination of colour and typeface) go to the 'Property' menu, and
select the 'Concept Style Properties' option. This will display the Style Properties dialog box
showing the various functions (see figure). From here a new style can be created by selecting the
'New Style' button and then entering a style name - this will appear under the 'Style name' list
box. The fonts, colours and type sizes can then be selected using the 'Font' button which will
enable the 'Font selector' box. The background border can be changed using the Border button.
This process can be repeated for as many as twenty styles. To finish click on the 'OK' button.
Note: The range of colours available through this process is determined by the hardware. Most
hardware will support 16 or 256 solid colours.
To delete a style within the Style Properties dialog, select the style to be deleted then click on
'Delete'. This cannot be done if the style is in use.
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Selecting styles

Once styles have been defined, it is possible to assign them to concepts using the style selector
facility. To display the style selector go to the 'Property' menu and select the 'Show style selector'
option, or hold down the Alt key and press Y i.e. Alt-Y. To change the style of a concept, select it
(it is possible to select more than one concept - see Selecting Concepts 36 ) the style selector will
then change to highlight the name of the current style. Clicking on the name of the required style
will then change the concepts' style. The style selector can also be used to review which the style
of each particular concept. With the style selector active, whenever a concept is selected, the
style selector indicates that concept's style.

Note: In some of the sections which follow, styles such as issue, goal, action etc. are used in
examples. These sets are not intrinsic to Decision Explorer models but are merely part of a
convention, "cognitive mapping", for defining categories of concepts through the use of styles.

7.3

Link styles

Link styles are similar to concept styles, allowing you to define your own visual indicators. They
can be changed using the Property menu Link Style Properties command, and are fully explained
in the Reference Manual.
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Sets

A set is a method of managing and organising concepts in the model. Sets can comprise any
concepts or 'slices' (see Analysis Available 66 ) of the model that seem appropriate, the most
common requirement being that of coding the concepts to relate to particular aspects of the
model. For example, it may be useful to place either a particular type of concept (e.g. goals or
actions) or those concepts concerning a particular topic, Europe for example, into one easily
accessible location (a set). These sets can then be listed, changed or used as the basis for
analysis.
Some sets are created automatically (they are 'intrinsic' to the model). For instance, concepts
sharing a particular style will form an intrinsic set and can be used as such e.g. issue. This also
applies to two other intrinsic sets selected concepts, "sc", and those concepts in a map view
called "onmap". All these sets change dynamically (they are automatically updated to match the
current situation) and can be used in the same fashion as any of the sets created below.

8.1

Creating sets

The first step in creating a set is to give it a name, which may be any name that is appropriate.
For example, to create a set containing concepts about Europe type newset Europe or ns
Europe. To add concepts to the set type the setname followed by '=L' and the concept numbers
required (separated by either a '&' or '#' character). So, for example, to add concepts 23,45,22,56
and 64 into the Europe set, the command typed is Europe = L 23 & 45 & 22 & 53 & 64 (the '=' is
to specify the set that it is to contain some items and 'L' is the command to use when adding a
list). A message to confirm that the concepts have been added will be shown e.g. 'Europe now
has 5 concepts'. Click on 'OK' and any concepts in the Europe set will be replaced with those
listed.
To put additional concepts into a set the '+' sign is used e.g. Europe +L33 would add concept 33
to the Europe set. To remove concepts from a set use the '-' sign e.g. Europe -L33. Sets can be
also be added to or subtracted from other sets e.g. Europe + L onmap or Europe -L England.
When concepts or sets are added to or removed from a set the message giving the final number
of concepts in the set is shown.

8.2

Listing sets

To find out what sets are available (and this includes clusters, see Analysis Available 66 ) the LS
command is used. This will display a list of any sets created by the user and those which are the
results of analysis, along with their size. LS does not, however, show any of the intrinsic sets
mentioned above. To see the contents of these sets, type L and the name of the intrinsic set, for
example L sc lists those concepts currently selected.
The L command also works with styles allowing lists of goals, actions etc. For example, L goal
would list all the concepts with the style goal.
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Advanced Features
Merging Concepts

This facility is used most often when a series of individual maps have been created and entered
into the model and duplicate concepts/ideas become apparent. Merging enables two identical
concepts to be combined into one without losing their corresponding links.
To do this, select the two concepts to be merged (click on each while holding down the Shift
key). Then select the 'Edit' menu 'Merge' option (Note: it is only enabled if exactly two concepts
are selected). The 'Merge' dialog box will appear and the way the concept text is to be merged
can be selected (see figure). Typing 'merge' followed by the concept numbers in the command
line will also cause this dialog to appear.
Note: This command is irreversible. Undelete can be used to retrieve the overwritten concept
but the links are not reverted back to their original form.

9.2

Re-numbering Concepts

The renumbering feature has a variety of purposes. One use is when the identification of
authorship is required. In this case, a series of numbers can be assigned to each person (e.g. 1200 for Kenny, 201-400 for Fran etc.). Later, the renumber facility can be used to change the
ranges to make more space for additional concepts.
To renumber a range of concepts select the 'Edit' menu 'Advanced' option. This will display
further options, one of which is 'Renumber'. Select 'Renumber' and the dialog box will appear.
The number in the 'From' box indicates the start of the range and the 'To' box number indicates
the end of the range (see figure). It is legitimate to have the From and To numbers the same to
renumber a single concept, however it is quicker to renumber a single concept by editing a
concept number in the normal manner (see Editing concepts 32 ). The 'Start At' box allows you to
specify the new start number for the specified range. Click on 'OK' when ready. Decision
Explorer will refuse to overwrite any existing concepts and will indicate if this is the case. Try
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again with another range. Once the concepts have been renumbered this is irreversible.

9.3

Mixing Numbers

The alternative to renumbering concepts is to mix their numbers. This is most often used to hide
the source of the concepts, i.e. when people know that 200-400 were from Peter, changing them
removes that information. As mixing only uses the existing numbers it is often better to renumber
them before mixing. Full details of this feature are available in the Help (F1) and the Reference
Manual.

9.4

Other Features Available

The features below are further explained in the Reference Manual.
Help

Can be obtained by going to the 'Help' menu and selecting the appropriate
option. Alternatively, the F1 key can be pressed at any time, which will
display help appropriate to the current menu, dialog etc. Context sensitive
information concerning all the features of Decision Explorer can be
accessed in this manner.

Model Display/
Options

Allows a variety of different ways of displaying the model information. For
example, whether page breaks, numbers and other concept items are
normally displayed.

Copy and Paste

Allows all or part of the model to be selected and copied into alternative
models for further review or into other Windows programs for display etc.

9.5

Escapes

There are two forms of escape.
To escape from a command before it completes its task, press the Esc key. You may wish to
escape in the following situations: where the command line has appeared but is not required; if a
command you are typing is no longer required; when editing a concept on-screen; or when a
menu has popped up. In each case, pressing the Esc key once or twice will usually free the
program and cancel the command.
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Where error and status messages are shown (in the form of a box appearing in the centre of the
screen) they will generally indicate their causes. They can be cancelled by clicking on 'OK' or
pressing Enter or Esc. If the cause is not immediately apparent e.g. one error message reads
"expected a string parameter", then it is advisable to consult the help facility by pressing the F1
key which describes how to use the command or procedure causing the error message.

© 2017 Banxia Software Ltd

Part

X
Hints and Tips

62

10
10.1

Decision Explorer® User's Guide

Hints and Tips
Moving the 'Window' Around the Map.

This operation is useful when there are more concepts on the map than can be seen on the
screen. The window onto the map needs to be moved up, down, left or right and this is easily
achieved in Decision Explorer.

10.1.1

Moving up and down

One way of moving around a map when there are concepts 'off the screen' has been mentioned
earlier - using the scroll bars. This is achieved by moving the mouse to the small box in the scroll
bars and click and hold to drag the box either up or down the scroll bar as required. To move
quickly down a view to look at concepts below the current screen display press Page Down.
Correspondingly, to move up to look at concepts above the current screen display press Page
Up.

10.1.2

Moving left or right

Moving left and right of the current view is similar to moving up and down, however, the b key is
used in addition to distinguish the different directions. To move to a left 'page' press Ctrl-Page
Down, to move to a right 'page' press Ctrl-Page Up.

10.2

Techniques to Enhance Speed

10.2.1

Quick method for 're-drawing' the screen

To redraw the screen press F5. This is especially useful as it 'refreshes' the screen to display any
changes made and removes any superfluous material. For example, when concepts have been
moved around the screen, or when the printer format for the map has been altered.

10.2.2

Quick access to previous commands

It is possible to return to the previous five entries to review or repeat a previous command or
concept typed on the command line. For example, if there are three clusters worth examining,
the previous command can be displayed - "Map cluster1" - and instead of having to repeat the
command completely, it can then be quickly edited to "Map cluster2".
Repeating commands is achieved by pressing the cursor up key. Previous commands will be
displayed on the command line in reverse order. Pressing the cursor down key allows a
command which has previously been used to be selected. Ec cancels the action.

10.2.3

Quick method for 'bringing' unlinked concepts onto a
view

When working with models at an early stage there are often a number of unlinked concepts (for
example, when merging a number of cognitive maps). The obvious method to bring selected
concepts onto a view, is the command Bring SC, but this spreads the concepts laterally across
the screen. Using the following steps, the concepts can be brought onto the screen in a single
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group, thus making identification and linking easier.
The first step is to list the ideas on the screen. This might perhaps be done through a 'Find'
command or a 'List' command. Once the specific concepts are listed, select them (see Selecting
Concepts 36 ). Move to a map view (see Viewing Concepts 40 ) and bring one of the selected
concepts onto the screen e.g. Bring 66, taking care not to deselect anything. Then holding down
the Shift key move the selected concept on the screen and the remaining selected concepts will
appear located around the chosen selected concept. (For more information on extending maps
see Extending Existing Maps 48 )

10.2.4

Quick method of 'bringing' concepts onto a map from
another display

When working with multiple views (see The Multiple View Facility 40 ) this technique enables
concepts identified on other views to be 'brought' quickly onto the current view. For example, if a
'FIND' command has been executed and several of the concepts listed appear relevant to the
screen being developed, then it is possible to bring them onto the screen without having to use
the 'Bring' command. This is achieved by selecting the concepts (see Selecting Concepts 36 ) in
either the text view or an alternative map view, returning to the view under consideration and
pressing Ctrl-B (for Bring). This is because 'Bring' operates on the selected concepts, even if
they are not on the map already.

10.2.5

Quick method of 'hiding' concepts on a map

This facility is useful for hiding a number of concepts on a map in order to reduce the amount of
complexity. Select the concepts and then remove them from view by pressing Ctrl-H (for Hide).

10.3

General Operation

10.3.1

Different forms of listing

There are a variety of different forms of listing which are useful when working with a large model,
and where listing the entire contents would be a lengthy operation.
· Listing a range
This is achieved by typing L and then the range separated by a '-' character. For example, L 3050 would list all those concepts between 30 and 50 inclusive.
· Listing from a set point
This allows everything after a specified number to be listed. For example, L 40- would list all
concepts from 40 onwards.
· Listing to a set point
Like the above except it lists everything up to a specified number. For example, L -40 would list
everything up to, and including 40.
These ranges can be used with most commands that list concepts. The shortcut commands
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which match the 'List' menu options are included in the menu text. For example, the 'List
relationships' menu shows "LR". The command LR 30-50 will only display the relationships of
concepts 30 through to 50.

10.3.2

Entering an opposite pole

In addition to simple phrases in the text of concepts, Decision Explorer also allows an "opposite
pole" to be included. Opposite or contrasting poles of an idea are often useful to distinguish more
clearly what is meant by a particular idea. They are often used in every-day speech, for example
'travel by car rather than take the bus'. To access this "bi-polar" feature, a single period between
the first and second poles is required. For example, if the idea to be entered is 'increase research
funding rather than remain at the same level' type =increase research funding.remain at the
same level and press Enter. The single period will then appear on the screen as an ellipsis
(three dots) which acts as a short hand for 'rather than'.

10.3.3

Identification of 'orphans'

Identifying orphans, i.e. those concepts with no links, is very useful when creating models as it
allows those concepts currently unconnected to be located quickly. To use this facility type
orphan and a list of unlinked concepts will be displayed.

10.3.4

Styles and printing

This section includes some helpful 'rules of thumb' when using styles:
· Avoid creating style names beginning with numbers or using special characters e.g. '/', '#' etc.
These characters are used extensively in commands and may be confusing to Decision
Explorer.
· Use True Type fonts rather than device specific fonts as they are more flexible. Typically these
are Arial, Courier New and Times New Roman.
· It is helpful to start with an initial style size of 12 point as this is both readable on screen and
workable in printed format.
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Analysis Available

11.1

Introduction

Once a model has been created in Decision Explorer it is often beneficial to gain some idea of its
structure by being able to look at different aspects (slices). Therefore in order to facilitate working
with large amounts of information, particularly models of 150 concepts and over, a variety of
analyses have been developed and are described below. These descriptions range from the use
of simple analysis - such as listing the 'top' and 'bottom' concepts of a model - to more complex
and complicated analysis such as 'collapse' which can provide an overview of the model. As such
they will be addressed according to their relative degree of complexity, starting with the simple
analysis.
The analyses that are covered in this document are as listed below and are divided into separate
sections. More documentation on options is available in the Reference Manual and online Help
(F1).
LH and LT

Listing those concepts at the top (heads) and
bottom (tails) of the model

LSD, LSS and LSE

Analyzing the differences and similarities
between sets

Cluster

'Slicing' the model making more manageable
sets

Hieset

Creating hierarchical sets using a specific set
as a 'seed'

Potent

Identifying those concepts that are linked to
the greatest number of top concepts

Collapse

Reducing the model to a specific set while
maintaining any links

Domain

Examining the 'density' of immediate links
around concepts.

Cent

Examining the 'centrality' at varying levels of
single, or sets of, concepts

Cotail

Looking for 'key' options - branch points - in
the model.

Replace

Searching and replacing text

Review

Exploring a specified set of concepts

Loop

Searching for loops within the model and
placing them in sets

Cset

Exploring consequential paths between
particular sets/styles

Connect

Identifying concepts on the immediate
boundaries between sets or styles
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Strip

Reducing the model to display only concepts
with branch points

LSH

Searching for branch points between groups

Although the analyses have been written with the Cognitive Mapping Technique in mind they can
be quite suitable for other purposes. Care must be taken in interpreting the results especially in
the case of a cluster analysis which analyses the structure of the model (and therefore places
emphasis on the cognitive mapping rules) to produce groups. Consequently although guidance
will be given in this section as to why the analysis may be used, it is done with Cognitive Mapping
in mind. Decision Explorer has a program language that can be used for developing analysis of
your own modelling techniques.

11.2

LT/LH

A quick and simple method for examining the top and bottom layers of the model is to List Heads
and List Tails.
Heads are those concepts that are at the top of the model - i.e. having no arrows leading out of
them - and tails are those concepts with no arrows leading into them. In a cognitive map, these
two analyses may be used for a variety of purposes - it has been found that they are often useful
to tidy up a model in the early stage of analysis, especially in the case of heads.
It is frequently the case, especially when working with multiple sources of information, that
concepts may appear as heads due to links not being made. Thus it is possible to identify
concepts which are not yet linked appropriately. Alternatively, when working with listing tails it is
possible to determine whether sufficient detail has been captured. In cognitive mapping the
heads are normally desired outcomes and the tails are possible actions.
Note: Concepts that have no links either going in or out of them are considered heads and will
be displayed as such. The 'orphan' command can also be used to find these.
Both of these analyses appear under the 'List' menu but can also be accessed through the
command line by typing LH (list heads) or LT (list tails).

11.3

Set Logic - LSD, LSS, LSE

Once the model has been built and some sets created (see Creating sets 56 ) it can be useful to
analyse the model through examining the differences and similarities between members of sets.
For example, it may be beneficial to explore whether there are any concepts in the intrinsic set or
style issue that also appear in the user created set which contains concepts to do with finance.
There are three types of logic analysis available, List Set Differences, List Set Similarities and L
ist Set Exceptions.

11.3.1

LSD

The command 'List Set Differences', for example lsd set1 set5, identifies the differences
between 'set1' and 'set5' and lists them to the screen in text mode. Thus it displays any concept
members that are not in the overlap between 'set1' and 'set5'.
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LSS

The command 'List Set Similarities' identifies those concepts that are in both sets and in a similar
manner to LSD the command is lss set2 set7. This will identify those concepts that are in both
'set2' and 'set7' and display them on the screen in a list.

11.3.3

LSE

The command 'List Set Exceptions' enables the user to identify which concepts are in one set but
not in the other. For example, lse set6 set3 determines which concepts are in 'set6' but are not
members of 'set3'. For this command it is important which set is listed first, for it is members of
this set that are of interest.

11.3.4

Using the results

The output from set logic analysis can be put into a further set, for example, newset diff; diff =
lsd set16 set3 will put the concepts that are not in the overlap between 'set16' and 'set3' into the
set called 'diff'.

11.4

Cluster

As models become complex through the capturing of huge amounts of data, they can no longer
be easily understood when mapped on the screen (rule of thumb suggests this to be around 40
concepts). The 'cluster' analysis helps with this by breaking down the model into more
manageable 'chunks'. This is useful for identifying key areas, isolated concepts which require
further links, or small relatively unlinked groups of concepts (which may require further linkage).
The analysis takes no account of the concept text and meaning, as the underlying assumption is
that the meaning of a concept is gained both from its content and from the concepts to which it is
linked, and it is the relationships which are important in this analysis. Thus, the analysis aims to
provide a list of "suggestions of mutually exclusive topic areas", but further content analysis is
usually required to identify more reliably the boundaries of each topic. Cluster analysis results
should always be treated cautiously because the analysis relies not only on the cognitive
mapping formalisms but also on the model being comprehensive, which is never the case.
Essentially a cluster analysis tries to determine relatively isolated "islands" of concepts where
there are a minimum of "bridges" between the islands. Therefore the contents of the clusters
produced are mutually exclusive (as opposed to Hieset - see Hieset 69 ).

11.4.1

Creating clusters

To do a cluster analysis simply move to the 'Analysis' menu and select 'Cluster'. Once the
analysis is completed the message alongside will appear and the sets can then be viewed. To
access the analysis from the command line type cluster and it will be carried out. For more
advanced use, refer to the 'Cluster options' under the 'Analysis' 'Configure' option, which is
described in the Reference Manual. Note that previous clusters are destroyed each time the
analysis is done.
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Viewing clusters

Once the cluster analysis has been completed it is then possible either to list or map each
cluster. The analysis puts the results (clusters) of linked concepts into sets which it names
Cluster1, Cluster2, etc. To see how many clusters there are and the number of concepts in each
cluster use the list set command i.e. ls. This facility can also be accessed from the menus, select
the 'List' menu 'Sets' item and all sets in the model will be displayed. (Note that ls cluster will list
only sets beginning with Cluster). To examine the contents of any cluster either type map
clusterX to produce a graphical display or type L clusterX to view a list of concepts in that
cluster. Note that the X above denotes the cluster number.
The output from a cluster analysis should be treated with care. The analysis is based only on
structure, not on content. The analysis may reveal emerging characteristics of the model such as
themes, topics, problem areas etc. The only characteristic that can be reliably indicated is the
relative intensity of linkages between concepts -a model which cannot be split up into parts must
be worked on holistically whereas well separated small clusters indicate a small amount of
bridging between these different parts of the model.

11.5

Hieset

The aim of this analysis is to produce hierarchical sets or groups based on a specified set of
concepts (concepts that 'seed' the hierarchical sets). Each hierarchical set will contain one of the
specified set and all the concepts that explain it - i.e. are the means by which the concept in
question can be achieved. However, if the analysis, in tracing down the chain of argument,
reaches another of the specified seed set it will stop and not proceed further down that particular
chain of argument.
Once the analysis has been executed it is possible to determine which specified concepts are
well elaborated (i.e. create large groups), and which are not, by reviewing the size of the groups
produced. If some of the sets produced are large e.g. greater than 50 concepts, it may suggest a
review of the seed set to include some from the large group.
To carry out the Hieset analysis a set containing the specified concepts will need to either exist
already or be created (see Creating sets 56 ). This set can be one of the style sets e.g. issue, a
combination of styles or a content related set. Once the set is in existence type hieset and the
name of the set e.g. hieset issue and press Enter. The analysis will then be run and when
complete a message box will appear on the screen (see figure).
The Hiesets can be accessed in a similar manner to the other sets by typing LS (list sets).
Further exploration is possible by typing either L HiesetX (where X is the relevant number) for a
list of the contents of the hieset or Map HiesetX to gain a graphical representation.
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Potent

This analysis is used in conjunction with the Hieset analysis as it takes its information from the
sets created by Hieset.
By examining the contents of each of the sets created by the Hieset analysis, Potent identifies
which concepts appear in the most number of sets and thus determines their 'potency' within the
model. A list of these 'potent' concepts is then displayed in descending order of potency.
It is possible to specify whether this analysis is to be carried out for all concepts in the model, or
on just the 'top ten'. The display will either list all the concepts in order with their potency score
alongside or list the potency value in descending order followed by the concepts. It is also
possible to restrict this analysis to a particular set thus gaining some idea of the potent ideas
within it.
To run this analysis for a full list, type Potent. This will cause all the concepts in the model which
are contained in the Hiesets to be analysed and listed accordingly (see example). If only a top
potency display is required, type potent and the number of concepts required, e.g. Potent 5.
This will cause the most potent five concepts to be listed on the screen.
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As mentioned earlier, it is also possible to identify either all or a specified number of potent
concepts from one particular set. To do this type potent and the number of concepts, and then
the name of the set e.g. potent 10 issue. If all the concepts in the set are to be listed rather than
a top percentage then a zero must be entered between the command and the set in question.
For example, potent 0 client will cause all the concepts in client to be listed (see example).
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If you want to use Potent on sets that are not derived from Hieset, you can use the Potentset
variant. See the Reference manual for details.

11.7

Collapse

Models created in Decision Explorer are often very complicated to work with, having a large
number of concepts and links. Therefore in many cases it has been found to be helpful to obtain
an overview of the model by considering only a small number of significant concepts, while
retaining any indirect linkages between them as if the intermediate concepts still existed. For
example, it may prove useful to collapse onto a set of concepts relating to finance to observe
how they are interlinked or to collapse onto the key issues to provide a means of navigating
through the model.

11.7.1

Collapsing a model

To collapse on a set, type col followed by the name of the set, e.g. col myset. This will cause
those concepts that are not in the set to be 'hidden', and only those in the set displayed. Any
linkages between these concepts are determined by analyzing the paths between each member
of the set, and where a path exists a link will be displayed. Due to the model often containing
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more than one route between the concepts it may be difficult for the analysis to determine
whether a negative sign or positive sign should be attributed to the link in the case of both route
types existing. Thus, some of the links between the displayed concepts may appear a little 'out of
place'.
Below is an example of a model before and after a collapse. Those concepts that are boxed in
the figure are the ones being collapsed upon. As can be seen in the second figure, the
intervening concepts have been hidden but their links taken into account.
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While the collapse mode is in operation, the collapsed model can be used in exactly the same
way as the original model - indeed a further collapse may be made. However, Decision Explorer
may slow down. In order to tell when a model is collapsed the set name is displayed in the title, if
the option is enabled in the 'Control' menu 'Preferences' item (see "selected" in the example
above).

11.7.2

Undoing a collapse

When work on the collapsed model is complete it is possible to return to the original (previous
level) model by typing the command uncol followed by the set name.
Note: It is possible to collapse onto a composite set of styles by building a set containing more
than one style (see creating sets), for example typing the following command sequence newset set1
set1 = l style4
set1 + l style6
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col set1
will create a new set called 'set1'; add all the concepts in 'style4' to the empty set; add all
concepts in 'style6' to the existing contents of 'set1'; and collapse on 'set1'.
It is often useful to "copy and paste" the collapsed model into a new model for retention. The
command colcopy helps with this in large models where collapsing is slow.

11.8

Domain

The Domain analysis examines each concept and calculates how many concepts are
immediately related to it (i.e. directly linking in or out of the concept). Through this it is possible to
be able to identify which concepts are the best elaborated or have a high density of links around
them. This may provide some idea of which concepts are key issues and may warrant further
examination. Furthermore, in a similar manner to the Potent analysis it is possible to focus on
only those concepts which are the most densely linked.
To get a list of all the concepts in the model and their relative densities type dom on the
command line. This causes each concept to be displayed in numerical order along with the
number of concepts linking in, out and a total score. In cases where the model has a large
number of concepts this may cause the analysis to 'scroll' the list. It is possible to stop or pause
the analysis by clicking on the appropriate buttons. To view material scrolled off the screen press
Page Up or Page Down as required.
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Domt

To display a list of just these concepts with the highest density in the model, type domt and then
the required number e.g. Domt 10. This will provide a list of the ten most densely linked concepts
in the model.
As can be seen in the example above, the concepts are listed in descending order, beginning
with a list of those which have the most number of links, and continuing down until the number of
concepts requested is reached. Domt can also be run on a specific set only (e.g. Domt 10
option, to determine which options have the greatest density). If the analysis is to be run on all
members of a set, a '0' (zero) must be included between the command and the set name e.g.
type Domt 0 issue.
Note: When listing the results of the analysis the styles of the concepts will be used so that it is
possible to see the category of each concept.
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Cent

The Centrality analysis allows a similar calculation to that of domain density (see "Domain", p66)
to be carried out. However this analysis calculates the result using more than one level, i.e. not
just those concepts that immediately link into the specified concepts but also those which link
through them. This provides some insight into discovering the centrality of the concept in the
whole model rather than just its immediate vicinity.
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The analysis uses a scoring system for calculation. For each level away from the central concept,
the score attached to the number of concepts is reduced. Those concepts immediately linking
into the central concept score 1, those concepts that link into them score 0.5, those that link into
them score 0.33, and so on up to 7 levels out. The figure displays a centrality analysis with 4
concepts (each worth 1) in the first level, 5 concepts (each worth 0.5) in the second level, 4
concepts (each worth 0.33) in the third level, and 2 (worth 0.25) in the fourth. This would give the
central concept a centrality score of 8.32. Furthermore, Central provides a centrality score that is
independent of direction.
There are a number of parameters available to make it as flexible as possible. The first
parameter controls whether to calculate the whole model or just limit it to a number at the top. If
the analysis is to be carried out on all, then a '0' (zero) must be entered. When specifying
parameters, the second parameter allows the analysis to be carried out upon a particular set or
style. If all the concepts are to be calculated, then the word 'every' must be included. Finally, the
maximum level of the central analysis can be set from 1 to 7 (the default is 3). Calculating the
centrality of concepts seven layers out does require a significant amount of processing time.
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To carry out a centrality analysis of the top 10 concepts on the set 'issue' for 2 levels type Cent
10 issue 2. An example of the results is shown in the figure alongside. To run the analysis to
look for the top 10 of all the model for three levels type Cent 10 every. As the level required is
the default, and all the model is to be considered, it is not necessary to add these. If the analysis
is to be carried out on more than 100 concepts (i.e. the whole model or a large set or style) then
a warning appears indicating this may take time and provides an abandon facility.

11.10

Cotail

Cotail (standing for Composite tails) is an analysis which searches through the model to find
those 'potential' options which have more than one outcome, i.e. more than one consequence
leading from them. Starting from the bottom of the model - the tails - the analysis traces up each
chain of argument until it meets one of these branch points. It flags this as a composite tail and
starts with the next chain of argument. Once the analysis has identified all those concepts that fit
the requirement, they are then listed on the screen according to their style as can be seen in the
example. Any concepts which are already in a set called 'option' are listed first, followed by the
other styles. The analysis is accessed by typing cotail at the command line.
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The results of this analysis are useful for identifying potential options. Concepts in the display can
be selected and their style changed using the style selector (see Styles 52 ).
It is sometimes worth comparing these results with those concepts identified through the 'Potent'
analysis in order to discover which appear in both, thus confirming their potency.

11.11

Search and Replace

Replace is, as its name suggests, a command which searches through the model to find all
occurrences of a specified word or string of words. For example the word "facilitator", is replaced
by a second word, or string, for example "consultant". The words or strings being searched for
and replaced must be enclosed in quotes in order to distinguish them in the command, for
example "facilitator". The command for this example would be, replace "facilitator"
"consultant".
The range of concepts searched within can also be limited by specifying a set at the end, for
example, replace "facilitator" "consultant" consult. A single concept e.g. 50, or a range can
also be used e.g. 50-60.
Note:

Changes made using 'Replace' cannot easily be undone.

© 2017 Banxia Software Ltd

Analysis Available

11.11.1

81

Adding text to the start or end of concepts

To add text to the start or end of a concept look up the 'Prefix' and 'Suffix' commands in the Help
or the Reference Manual.

11.12

Review

Review, as the name suggests, enables a review of a particular style or set of concepts using
one of the X (eXplore) commands (see Displaying Concepts as Maps 44 ). The analysis defaults
to a standard X display unless one of the other modes is specified. For example, XE (eXplore
Explanations), XC (eXplore Consequences), XI or XO (eXplore Ins and Outs respectively). Each
concept in the specified set is displayed on the screen with its immediate explanations and
consequences or appropriate linkages in order to provide some context to its content, see figure.
At any point in the analysis it is possible to stop and work on the display as necessary by
pressing the 'Cancel' button. To run the analysis on the full model in the XC mode type review
every XC. The "every" signifies that all concepts in the model are to be analysed.
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Review styles and sets

To carry out this analysis on a style of concept in the model, for example on 'issue', type review
issue. All those concepts within the model that have the style 'issue' are then 'reviewed' and
displayed one at a time. To carry the analysis out on a set the same process is used. To review
the contents of a set called 'client' type review client. Both styles and sets can also be displayed
with the different forms of explore, e.g. review client XC.

11.13

Loop

Loop analysis is used to detect loops in concept linkages within the model. This is useful either
for detecting valid loops within the model (that is a feedback loop exists for the issue) or for
tidying up any mis-linkages- common when working with large models of over 100 concepts. To
run the analysis type loop. The message "performing loop analysis - please wait" will appear on
the screen as the analysis may take some time to complete. When the analysis is finished
another message announces that the results are in sets called loopX (where X represents a
number) which can be accessed by the 'ls' command (see Sets 56 ). These sets can then be
listed, or mapped as appropriate, for example, type map loop2 to display the contents of loop2.
The figure below is an example of a mapped loop. To review the list of loops type loopr.
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Cset

Cset (consequences for a set) enables a check to be run between specific sets or styles of
concepts to determine whether there are any instances where the second set contains concepts
that are consequences of the first. This analysis checks along a path of argument for the
consequences rather than just examining the immediate concepts. There are three different
modes for running this analysis to provide as much flexibility as possible. These modes make it
possible to determine whether a specific concept has consequences for a style or set, whether a
style or set has consequences for a specific concept or whether one particular style or set has
consequences for another. Styles and sets are interchangeable and it is also possible to place
the results of the analysis into a set called csetX (X represents a number) for further reference if more than one set is required these will increase numerically e.g. cset1, cset2 etc.

11.14.1

First mode - one specific concept to all (of a set or style)

This mode checks whether a specific concept has any consequences in the specified set or
style. By typing Cset "35" issue then any issues that are consequences of 35 will be listed.
These can be put into a set by typing cset "35" issue s - the single 's' signifies that the set option
is desired.

11.14.2

Second mode - all (of a set or style) to one specific
concept

This mode checks whether a style or set has any consequences on a specific concept. For
example, to determine whether any members of the set 'client' are explanations for concept 30
type cset client "30". If there are any they will be listed on the screen (see figure) or put in a set
if the set option is specified.
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Third mode - all (of a set or style) to all (of a set or style)

This can be useful when examining whether one particular style affects another and if so how
often. It is possible to determine, for example, whether there are any issues that have options as
consequences or vice versa. If there is a hierarchy of styles developed within the model this
analysis can be used for testing integrity. Alternatively it can be used to explore whether a
specific set of concepts has any impact upon another set or style. For example, whether the set
containing all the information about Europe affects the goals in the model and if so to what
extent. The command used to undertake this mode is achieved by typing cset issue option
(when identifying whether one style has consequences for another) or cset Europe goal (when
discovering what the impact of the set 'Europe' is on those concepts with the 'goal' style).Enter
topic text here.

11.15

Connect

This analysis, similar to cset, can be used for examining whether or not one set or style of
concepts directly leads out of, into, or connects with another. For example, it is possible to
discover whether there are any options directly leading into issues. It is different from cset in 2
ways. First, it only looks at those concepts that are directly linked to the specified set in question
whereas cset will search along the entire chain of argument. Second, there are three options
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available when reviewing the material. The first option - "outof" - provides the most similar results
to cset insofar as it provides a list of any immediate consequences of one set for another. The
second option - "into" - does exactly the opposite - lists any immediate explanations between the
two sets. Finally, the - "with" - option checks in both directions to determine whether the sets
contain concepts which link them either into or out of each other.

11.15.1

'Outof' option

This looks at those concepts that are in the second specified set which are immediate
consequences of those in the first. For example, to explore whether any concepts in the style
'issue' are immediate consequences of the style 'option' type connect issue outof option. The
analysis will then ask whether the results are to be placed into sets by displaying a dialog box
(see figure). If the results are to be placed in a further set for future examination they will be
placed in sets called connectsetX (X representing the number of sets created). If the results are
not placed in a set then they will be displayed on the screen.

11.15.2

'Into' option

This provides the facility to identify whether any concepts in the first specified set/style are
immediate explanations of the second. As in the previous option, there is the facility to place the
results into a set for further consideration - either sets or styles can be used. To determine
whether, for example, there are any issues that are direct explanations for the set mission type
connect issue into mission. The results will either be listed directly to the screen or stored in a
set if required.

11.15.3

'With' option

This option searches through both specified sets or styles in order to distinguish whether there
are any links directly between concepts in the two sets. The results are displayed either in two
lists on the screen or in sets. The first list shows those concepts in the first set that are going into
the second, whereas the second list displays those concepts in the first set that are
consequences of the second. (see example). As in the other two options either styles or sets can
be used, and the results can be stored in sets. To run this, for example, type connect client
with issue.
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Strip

It is often helpful to reduce the size of the model by stripping out the concepts that only elaborate
it, i.e. they have no branched explanations or consequences. This process can often provide a
useful overview of the model. It operates using the collapse facility, so stripped concepts are only
hidden not deleted. A concept with no explanations and one consequence - e.g., a tail which acts
as a detailed option to a more superordinate option and thus will not be worth considering unless
the single option it supports is of interest - is stripped out. Similarly, a concept with no
consequences and one explanation will be stripped out. Finally, concepts with one explanation
and one consequence which are neither heads nor tails - a single line of argument which
represents detailed elaboration - will be simplified by retaining the link but removing the
elaborating concept. This analysis can only be run once before uncollapsing the result or an error
message will appear.
In operation this analysis creates a set called "stripset". The summary, or overview, is created by
using the collapse command (see Collapse 72 ) with "stripset" as the set (note that the screen
header will be indicating a "stripset" collapse). To activate the analysis type Strip. Often the
summary model is of more permanent interest and is worth analysing in its own right. In these
cases it is useful to copy and paste the results to a new model (see the Reference Manual or
Help). After viewing the stripped down model it is possible to return to the original model by
typing uncol stripset.
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It is sometimes useful to categorise separately, all or some of the concepts that remain after a
strip. This is a simple process undertaken by creating a new style while in collapse mode,
selecting the strip concepts of interest and changing their style (see Styles 52 ). Any changes
made in the collapse mode are retained after the model has been uncollapsed.

11.17

Lsh

It is often helpful to explore the relationship between sets, that is, the nature of interconnection
between sets. For example, after the cluster command is used to create clusters it is usually
interesting to note the directionality of "bridging" concepts between clusters. The command
'lsh' (list set hierarchies) finds these bridges and reports the direction of the links.
There are three ways of executing the command. First, to report links between all sets type lsh.
This will cause any 'bridges' occurring within and between both styles and sets to be reported.
See example below.
Second, to explore a specific type of set, for example, between clusters type lsh cluster r ('r'indicating an interest in a range of clusters). To do this on hiesets type lsh hieset r. The 'r'
parameter can be used to examine any range of sets so bridges between connectsets or
loopsets can also be explored.
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